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Preface

Welcome to the Oracle� Engineering User’s Guide, Release 11i.

This user’s guide includes the information you need to work with
Oracle Engineering effectively.  It contains detailed information about
the following:

• Overview and reference information

• Specific tasks you can accomplish using Oracle Engineering

• Oracle Engineering setup

• Oracle Engineering functions and features

• Oracle Engineering windows

• Oracle Engineering reports and processes

This preface explains how this user’s guide is organized and introduces
other sources of information that can help you.
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About This User’s Guide

This guide contains overviews as well as task and reference
information about Oracle Engineering.  This guide includes the
following chapters:

• Chapter 1 contains all setup information and procedures
including Profile Options.

• Chapter 2 provides an overview and procedures for defining
engineering change orders (ECOs).

• Chapter 3 describes how to utilize ECOs in an engineering
prototype environment.

• Chapter 4 describes all Engineering reports.
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Audience for This Guide

This guide assumes you have a working knowledge of your business
area’s processes and tools.  It also assumes you are familiar with Oracle
Engineering.  If you have never used Oracle Engineering, we suggest
you attend one or more of the Oracle Engineering training classes
available through World Wide Education.  For more information about
Oracle Engineering and Oracle training, see: Other Information
Sources.

Do Not Use Database Tools to Modify Oracle Applications Data

Because Oracle Applications tables are interrelated, any change you
make using Oracle Applications can update many tables at once.  But
when you modify Oracle Applications data using anything other than
Oracle Applications, you may change a row in one table without
making corresponding changes in related tables.  If your tables get out
of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle
Applications.

When you use Oracle Applications to modify your data, Oracle
Applications automatically checks that your changes are valid.  Oracle
Applications also keeps track of who changes information.  If you enter
information into database tables using database tools, you may store
invalid information.  You also lose the ability to track who has changed
your information because SQL*Plus and other database tools do not
keep a record of changes.

Consequently, we STRONGLY RECOMMEND that you never use
SQL*Plus or any other tool to modify Oracle Applications data unless
otherwise instructed.

Other Information Sources

Here are some other ways you can increase your knowledge and
understanding of Oracle Engineering.

Online Documentation

All Oracle Applications documentation is available online on
CD–ROM, except for technical reference manuals.  There are two online
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formats, HyperText Markup Language (HTML) and Adobe Acrobat
(PDF).

All user’s guides are available in HTML, PDF, and paper.  Technical
reference manuals are available in paper only.  Other documentation is
available in PDF and paper.

The content of the documentation does not differ from format to format.
There may be slight differences due to publication standards, but such
differences do not affect content.  For example, page numbers and
screen shots are not included in HTML.

The HTML documentation is available from all Oracle Applications
windows.  Each window is programmed to start your web browser and
open a specific, context–sensitive section.  Once any section of the
HTML documentation is open, you can navigate freely throughout all
Oracle Applications documentation.  The HTML documentation also
ships with Oracle Information Navigator (if your national language
supports this tool), which enables you to search for words and phrases
throughout the documentation set.

Related User’s Guides

Oracle Engineering shares business and setup information with other
Oracle Applications products.  Therefore, you may want to refer to
other user’s guides when you set up and use Oracle Engineering.

If you do not have the hardcopy versions of these manuals, you can
read them online using the Applications Library icon or Help menu
command.

Country–Specific User’s Guides

These manuals document functionality developed to meet specific legal
and business requirements in more than 25 countries. You should use
the appropriate user’s guide, such as the Oracle Financials for
Germany User’s Guide, for more information about using Oracle
Financials in a specific country. Consult your country–specific user’s
guide, Oracle Financials Regional User’s Guide, and your financial
product’s manual to effectively use Oracle Financials in your country.

Global Accounting Engine

Use the Global Accounting Engine to replace the transfer to General
Ledger and create subledger accounting entries that meet additional
statutory standards within some countries. The Accounting Engine
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provides subledger balances, legal reports, and bi–directional
drilldown from General Ledger to the subledger transaction.

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate
using the graphical user interface (GUI) available with this release of
Oracle Engineering (and any other Oracle Applications products).  This
guide also includes information on setting user profiles, as well as
running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing ”Getting Started
with Oracle Applications” from any Oracle Applications help file.

Oracle Applications Demonstration User’s Guide

This guide documents the functional storyline and product flows for
Vision Enterprises, a fictional manufacturer of personal computers
products and services.  As well as including product overviews, the
book contains detailed discussions and examples across each of the
major product flows.  Tables, illustrations, and charts summarize key
flows and data elements.

Oracle Bills of Material User’s Guide

This guide describes how to create various bills of materials to
maximize efficiency, improve quality and lower cost for the most
sophisticated manufacturing environments.  By detailing integrated
product structures and processes, flexible product and process
definition, and configuration management, this guide enables you to
manage product details within and across multiple manufacturing
sites.

Oracle Financials Regional User’s Guide

This manual describes functionality developed to meet specific legal
and business requirements that are common to several countries in a
given region. Consult this user’s guide along with your
country–specific user’s guide and your financial product’s manual to
effectively use Oracle Financials in your country.

Oracle Flow Manufacturing User’s Guide

This guide describes how to use Oracle’s Flow manufacturing
functionality to support the processes of flow manufacturing.  It
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describes design features of demand management, line design and
balancing, and kanban planning.  It also describes production features
of line scheduling, productions and kanban execution.

Oracle Inventory User’s Guide

This guide describes how to define items and item information,
perform receiving and inventory transactions, maintain cost control,
plan items, perform cycle counting and physical inventories, and set up
Oracle Inventory.

Oracle Master Scheduling/MRP and Supply Chain Planning User’s
Guide

This guide describes how to anticipate and manage both supply and
demand for your items.  Using a variety of tools and techniques, you
can create forecasts, load these forecasts into master production
schedules, and plan your end–items and their component
requirements.  You can also execute the plan, releasing and
rescheduling planning suggestions for discrete jobs and repetitive
schedules.

Oracle Manufacturing Scheduling User’s Guide

This guide describes how to use Oracle Manufacturing Scheduling to
view and reschedule single discrete jobs or the entire shop floor.
Specifically, this guide details how to easily use the drag and drop
functionality to view and reschedule jobs, operations, and resources.

Oracle Order Management User’s Guide

This guide describes how to enter sales orders and returns, copy
existing sales orders, schedule orders, release orders, create price lists
and discounts for orders, run processes and create reports.

Oracle Work in Process User’s Guide

This guide describes how Oracle Work in Process provides a complete
production management system.  Specifically this guide describes how
discrete, repetitive, assemble–to–order, project, flow, and mixed
manufacturing environments are supported.
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Reference Manuals

Oracle Automotive Implementation Manual

This manual describes the setup and implementation of the Oracle
Applications used for the Oracle Automotive solution.

Oracle Manufacturing and Distribution Open Interfaces Manual

This manual contains up–to–date information about integrating with
other Oracle Manufacturing applications and with your other systems.
This documentation includes open interfaces found in Oracle
Manufacturing.

Oracle Applications Message Reference Manual

This manual describes all Oracle Applications messages.  This manual
is available in HTML format on the documentation CD–ROM for
Release 11i.

Oracle Project Manufacturing Implementation Manual

This manual describes the setup steps and implementation for Oracle
Project Manufacturing.

Oracle Self–Service Web Applications Implementation Manual

This manual describes the setup steps for Oracle Self–Service Web
Applications and the Web Applications dictionary.

Installation and System Administration

Oracle Alert User’s Guide

This guide explains how to define periodic and event alerts to monitor
the status of your Oracle Applications data.

Multiple Reporting Currencies in Oracle Applications

If you use the Multiple Reporting Currencies feature to record
transactions in more than one currency, use this manual before
implementing Oracle Engineering.  This manual details additional steps
and setup considerations for implementing Oracle Engineering with
this feature.
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Multiple Organizations in Oracle Applications

If you use the Oracle Applications Multiple Organization Support
feature to use multiple sets of books for one Oracle Engineering
installation, this guide describes all you need to know about setting up
and using Oracle Engineering with this feature.

Oracle Applications Implementation Wizard User’s Guide

If you are implementing more than one Oracle product, you can use the
Oracle Applications Implementation Wizard to coordinate your setup
activities.  This guide describes how to use the wizard.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle
Applications development staff.  It describes the Oracle Application
Object Library constituents needed to implement the Oracle
Applications user interface described in the Oracle Applications User
Interface Standards.  It also provides information to help you build your
custom Developer/2000 forms so that they integrate with Oracle
Applications.

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup and reference
information for the Oracle Engineering implementation team, as well as
for users responsible for the ongoing maintenance of Oracle
Applications product data.  This manual also provides information on
creating custom reports on flexfields data.

Oracle Applications Installation Manual for Windows Clients

This guide provides information you need to successfully install Oracle
Financials, Oracle Public Sector Financials, Oracle Manufacturing, or
Oracle Human Resources in your specific hardware and operating
system software environment.

Oracle Applications Product Update Notes

If you are upgrading your Oracle Applications, refer to the product
update notes appropriate to your update and product(s) to see
summaries of new features as well as changes to database objects,
profile options and seed data added for each new release.
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Oracle Applications Upgrade Preparation Manual

This guide explains how to prepare your Oracle Applications products
for an upgrade.  It also contains information on completing the
upgrade procedure for each product.  Refer to this manual and the
Oracle Applications Installation Manual when you plan to upgrade your
products.

Oracle Applications System Administrator’s Guide

This manual provides planning and reference information for the
Oracle Engineering System Administrator.

Other Sources

Training

We offer a complete set of formal training courses to help you and your
staff master Oracle Engineering and reach full productivity quickly.  We
organize these courses into functional learning paths, so you take only
those courses appropriate to your job or area of responsibility.

You have a choice of educational environments.  You can attend
courses offered by Oracle Education Services at any one of our many
Education Centers, or you can arrange for our trainers to teach at your
facility.  In addition, Oracle training professionals can tailor standard
courses or develop custom courses to meet your needs.  For example,
you may want to use your organization structure, terminology, and
data as examples in a customized training session delivered at your
own facility.

Support

From on–site support to central support, our team of experienced
professionals provides the help and information you need to keep
Oracle Engineering working for you.  This team includes your
Technical Representative, Account Manager, and Oracle’s large staff of
consultants and support specialists with expertise in your business
area, managing an Oracle8 server, and your hardware and software
environment.
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About Oracle

Oracle Corporation develops and markets an integrated line of
software products for database management, applications
development, decision support, and office automation, as well as
Oracle Applications, an integrated suite of more than 45 software
modules for financial management, supply chain management,
manufacturing, project systems, human resources and sales and service
management.

Oracle products are available for mainframes, minicomputers, personal
computers, network computers and personal digital assistants,
allowing organizations to integrate different computers, different
operating systems, different networks, and even different database
management systems, into a single, unified computing and information
resource.

Oracle is the world’s leading supplier of software for information
management, and the world’s second largest software company.
Oracle offers its database, tools, and applications products, along with
related consulting, education, and support services, in over 140
countries around the world.

Thank You

Thank you for using Oracle Engineering and this user’s guide.

We value your comments and feedback.  At the end of this guide is a
Reader’s Comment Form you can use to explain what you like or
dislike about Oracle Engineering or this user’s guide.  Mail your
comments to the following address or call us directly at (650) 506–7000.

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to appsdoc@us.oracle.com.
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Setting Up

his chapter tells you everything you need to know about setting
up Oracle Engineering.

• Defining ECO Types: page 1 – 9

• Defining ECO Autonumbering: page 1 – 11

• Defining ECO Priorities: page 1 – 14

• Defining ECO Reasons: page 1 – 16

• Defining ECO Approval Lists: page 1 – 17

• Starting the AutoImplement Manager: page 1 – 19

• Engineering Profile Options and Security Functions: page 1 – 20
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Setup Overview

This section contains an overview of each task you need to complete to
set up Oracle Engineering.

Before you set up Oracle Engineering, you should:

• Set up an Oracle Applications System Administrator
responsibility.  See: Oracle Applications System Administrator’s
Guide.

Oracle Applications Implementation Wizard

If you are implementing more than one Oracle Applications product, it
is recommended that you use the Oracle Applications Implementation
Wizard (AIW) to coordinate your setup activities.  The Wizard guides
you through the setup steps for the applications you have installed,
suggesting a logical sequence that satisfies cross–product
implementation dependencies and reduces redundant setup steps.

You can use the Wizard to see a graphical overview of setup steps, read
online help for a setup activity, and open the appropriate setup
window.  You can also document your implementation, for further
reference and review, by using the Wizard to record comments for each
step.

See Also

Oracle Applications Implementation Wizard User’s Guide

Related Product Setup Steps

The following steps may need to be performed to implement
Engineering.  These steps are discussed in detail in the Overview of
Setting Up sections of other Oracle product user’s guides.

Set up Underlying Oracle Applications Technology

The Wizard guides you through the entire Oracle Applications setup,
including system administration.  However, if you do not use the
Implementation Wizard, you need to complete several other setup
steps, including:
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• Performing system–wide setup tasks such as configuring
concurrent managers and printers

• Managing data security, which includes setting up
responsibilities to allow access to a specific set of business data
and complete a specific set of transactions, and assigning
individual users to one or more of these responsibilities

• Setting up Oracle Workflow

See Also

Oracle Applications Implementation Wizard User’s Guide

Oracle Applications System Administrator’s Guide

Oracle Workflow Guide
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Setup Flowchart

Some of the steps outlined in this flowchart and setup checklist are
Required and some are Optional.  Required Step With Defaults refers to
setup functionality that comes with pre–seeded, default values in the
database; however, you should review those defaults and decide
whether to change them to suit your business needs.  If you want or
need to change them, you should perform that setup step.  You need to
perform Optional steps only if you plan to use the related feature or
complete certain business functions.
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Setup Checklist

The following table lists setup steps and a reference to their location
within the Wizard. For a detailed description of AIW reference levels,
see the Oracle Applications Implementation Wizard User’s Guide. After you
log on to Oracle Applications, complete these steps to implement
Oracle Engineering:

Step
No.

Required Step AIW
Reference

Step 1 Required Set Profile Options Oracle
Engineering

Step 2 Required Enter Employee Oracle
Engineering

Step 3 Optional Define Change Order Types Oracle
Engineering

Step 4 Optional Define ECO Departments Oracle
Engineering

Step 5 Optional Define Autonumbering Oracle
Engineering

Step 6 Optional Define Approval Lists Oracle
Engineering

Step 7 Optional Define Reasons Oracle
Engineering

Step 8 Optional Define Priorities Oracle
Engineering

Step 9 Optional Start AutoImplement Manager Oracle
Engineering

Setup Prerequisites

Before you set up Oracle Engineering, you must complete the setup for
the following:

In Oracle Inventory:

– Define items.  See: Defining Items, Oracle Inventory User’s
Guide

In Oracle Bills of Material:

– See:  Setting Up, Oracle Bills of Material User’s Guide
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Step 2

Step 3
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Setup Steps

Set Profile Options (Required)

Profile options specify how Oracle Engineering controls access to and
processes data.  In general, profile options can be set at one or more of
the following levels: site, application, responsibility, and user.

Oracle Engineering users use the Update Personal Profile Options form
to set profile options only at the user level.  System administrators use
the Update System Profile Options form to set profile options at the
site, application, responsibility, and user levels.

Context:  Perform this step once for each entity, that is, site, application,
repsonsibility, or user..

See Also:  Oracle Engineering Profile Options and Security Functions:
page 1 – 20 and Update Personal Profile Options: page NO TAG(Oracle
Applications User’s Guide)

Enter Employee (Required)

Define employees for your organization.  ECO requestors and
approvers must be defined as employees.

If you do not install Oracle Human Resource Management Systems
with Oracle Engineering, you use the Enter Employee form to define
and maintain employees in Oracle Engineering.

If you install Oracle Human Resource Management Systems, you use
the forms in Oracle Human Resource Management Systems instead to
enter and maintain employees.

Context:  Perform this step once for each entity organization.

See Also:  Defining ECO Approval Lists: page 1 – 17

Define Change Order Types (Optional)

You can assign a change order type to your ECOs, either using the
’ECO’ change order type that Oracle Engineering provides or choosing
a change order type from any number of types you define using your
own terminology, such as Design Revision, Manufacturing Change
Order, or Substitution Waiver.  You can create change order types for
ECOs with manufacturing items, or manufacturing and engineering
items.

Default:  If you skip this step, Oracle shipped change order types will
be used as the default value.

Context:  Perform this step once per installation.
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Step 5

Step 6

Step 7
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See Also:  Defining ECO Types: page 1 – 9

Define ECO Departments (Optional)

You can group users that use the engineering change order (ECO)
system through ECO departments, creating multiple ECO departments
within your Inventory organization.  You can restrict access to ECOs by
ECO department and require an ECO department on all
ECOs—changing the responsible ECO department as the ECO moves
through multiple departments.

Default:  If you skip this step, <enter value here> will be used as the
default value.

Context:  Perform this step once per organization.

See Also:  Defining ECO Approval Lists: page 1 – 17

Define Autonumbering (Optional)

You can define customized autonumbering (for a user, organization, or
site) for new ECOs or mass change orders.  You can use the
autonumber default value when you define an engineering or mass
change order, or you can override the autonumber default and assign
your own number.

Context:  Perform this step once per organizational user.

See Also:  Defining ECO Autonumbering: page 1 – 11

Define Approval Lists (Optional)

You can define lists of approvers required to approve an ECO before it
can be released.  Oracle Engineering notifies the people on the list,
using an alert, that the ECO requires their approval.

Context:  Perform this step once per installation.

See Also:  Defining ECO Approval Lists: page 1 – 17

Define Reasons (Optional)

You can define reasons for engineering change orders using your own
terminology, such as Model Year, Design, Safety, and Ergonomic.  ECO
reasons are for your reference use only.

Default:  If you skip this step, Oracle shipped reasons will be used as
the default value.

Context:  Perform this step once per organization.

See Also:  Defining ECO Reasons: page 1 – 16
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Define Priorities (Optional)

You can define scheduling priorities for engineering changes to
describe the urgency of your ECO.  Priorities are for your reference use
only.

Default:  If you skip this step Oracle shipped priorities will be used as
the default value.

Context:  Perform this step once per organization.

See Also:  Defining ECO Priorities: page 1 – 14

Start AutoImplement Manager (Optional)

If you automatically implement ECOs, you must specify the frequency
that you want the AutoImplement manager to run.  Once an ECO has
been released to the autoimplement manager, you can automatically
implement all scheduled ECO revised items whose effective date is less
than or equal to the current date.

Context:  Perform this step once per organization.

See Also:  Starting the AutoImplement Manager: page 1 – 19
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Defining ECO Types  

Engineering change order (ECO) types help classify engineering and
mass change orders to items and bills of material, and determine
whether such orders apply to engineering in addition to
manufacturing.

An ECO type can be associated with an Oracle Workflow process.  If
so, a priority can optionally be associated with the ECO type.

If you define an ECO using a type and priority combination (even if the
priority is blank) that is associated with a workflow process, Workflow
will control the ECO approval process.  If the type and priority
combination is not associated with a workflow process, the ECO
approval status defaults to Approved.

� To define an ECO type:

1. Navigate to the Change Types window.

2. Enter alphanumeric text for a unique change order type.
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3. Indicate whether the change order type can revise both engineering
and manufacturing items and bills.

ECOs with an engineering change type can include both
engineering and manufacturing items; ECOs with a manufacturing
change type cannot include engineering items.

If an ECO with a status of Open, Hold, Release, or Schedule is
using this ECO type, this value cannot be updated.

4. Optionally, enter a description for the change order type.

5. Enter a date to inactivate the change order type.  As of this date,
you can no longer assign this change order type to a change order.

6. To associate this ECO type with a Workflow process, choose the
Processes button.

If you do not associate this ECO type with a Workflow process, any
ECO using this type will default to Approved.

� To associate an ECO type with a Workflow process:

1. Navigate to the Change Type Processes window.  Do this by
choosing the Processes button from the Change Types window.

2. Optionally, select an ECO priority.

Note:  ECO types are not organization–specific.  However, ECO
priorities are organization–specific.  This ECO type–priority
combination will only be available in the current organization.

3. Select a workflow process to associate with this ECO type.

Whenever this type and priority combination (even if priority is
blank) is used for an ECO, Workflow will control the ECO approval
process.

See Also

Overview of Engineering Change Orders: page NO TAG

Engineering Change Order Types Report: page 4 – 9

Workflow for ECO Approvals: page 2 – 11

Defining ECO Priorities: page 1 – 14
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Defining ECO Autonumbering 

You can define and update customized autonumbering to use as
defaults when creating new engineering change orders (ECOs) and
mass change orders.

Define autonumbering for a particular user in an organization, a user
across all organizations, all users in one organization, or all users across
all organizations.

When you first define an ECO, Engineering uses the following
hierarchy to determine the prefix to use for autonumbering:

• specific prefix for you and your current organization

• specific prefix for you across all organizations

• specific prefix for all users for your current organization

• specific prefix for all users across all organizations

For example, if a prefix is set up for you and the current organization, it
supersedes a prefix defined for you across all organizations.

When defining an ECO, you can either accept a default ECO number or
manually enter one.  Engineering displays the prefix along with the
next available number.  If Engineering does not find an autonumbering
prefix, you must assign an ECO number manually.

Attention:  When creating an ECO, once a default ECO
autonumber displays, Engineering considers that number
used—even if you do not save your changes and create the ECO
using that number.  For example, if you begin to define an ECO
called ABC234, and then decide to abandon your changes,
Engineering presents the next ECO number as ABC235.  You can
manually change this number.

Prerequisites

❑ Set the ENG: Change Order Autonumbering—System
Administrator profile option to Yes to define ECO autonumbering
for all users.  Set this to No to define it only for yourself.  See:
Engineering Profile Options and Security Functions: page 1 – 20.
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� To define ECO autonumbering:

1. Navigate to the ECO Autonumbering window.

2. Enter or select a specific UserName to define autonumbering for a
particular user, or select the All Other Users record to define
autonumbering for all other users.

If you only have privilege to define autonumbering for yourself,
the default is your username.
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3. Enter a specific organization to define autonumbering for a
particular organization, or select the All Other Organizations
record to define autonumbering for all other organizations.

Attention:  The information you provide in the Organizations
region is associated with the specific user or the All Other Users
record in the Users region.

4. Enter a prefix to use as the first characters for each defaulted ECO
identifier for the specific user or All Other Users, whichever is
currently selected.

You can define only one prefix per user per organization.  You can
define only one prefix per user across all other organizations.

5. Enter a Next Number to use as the of the base of the numeric
portion of ECO autonumbering.

The combined prefix and next number—the autonumber—is
incremented when each ECO is created.  For example, if you enter
100 and your prefix is ABC, the first ECO number is ABC100.  The
next will then be ABC101.

Each new ECO number is defaulted to one integer plus the last
used ECO number.  When defining a new ECO, you can override
this with a higher value.  The next ECO number will then be one
integer greater.  For example, assuming ABC as the prefix and no
ECOs defined using ABC, ABC1 is the default.  If you have defined
an ECO called ABC234, ABC235 is the default.

You cannot enter a prefix and next number that, when used
together, exceeds ten alphanumeric characters.

See Also

Engineering Change Orders: page NO TAG

Creating an ECO: page 2 – 23
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Defining ECO Priorities 

Engineering change priorities let you specify the urgency of the
engineering change order.  You can define a priority, enter a
description, and enter a priority level between zero and nine.

Note:  ECO priorities can be specified when associating ECO types
with Oracle Workflow processes, which are used for ECO
approvals.

� To define an ECO priority:

1. Navigate to the ECO Priorities window.

2. Enter alphanumeric text to describe a unique priority for an ECO.
For example, you could enter 1 to indicate an important priority.

3. Enter a priority sequence.  This is a number between 0 and 9.  For
example, you can use 0 to denote the highest priority and 9 the
lowest.

4. Enter a description for the priority.
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5. Optionally, enter a date on which the priority becomes inactive.  As
of this date, you can no longer assign the priority to an ECO.

See Also

Defining ECO Types: page 1 – 9

Engineering Change Order Priorities Report: page 4 – 4
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Defining ECO Reasons  

Use engineering change reasons to categorize and identify causes for
ECOs.  Engineering uses ECO reasons for reference only.

� To define an ECO reason:

1. Navigate to the ECO Reasons window.

2. Enter alphanumeric text to describe a unique reason for initiating
an engineering change.  For example, you could define a reason
OBSOLETE to indicate an obsolete part, or WAIVER to indicate a
component change on a bill of material.

3. Enter a description of the ECO reason.

4. Enter a date on which the reason becomes inactive.  As of this date,
you can no longer assign the reason to an ECO.

See Also

Engineering Change Order Reasons: page 4 – 5
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Defining ECO Approval Lists 

Engineering lets you define lists of approvers for ECOs.  Each approval
list can be used as a role by Oracle Workflow.

One workflow process, named “Standard Approval Process,” is
installed with Engineering.

� To define an ECO approval list:

1. Navigate to the Approval Lists window.

2. Enter the approval list name, a description, and, optionally, a date
on which you can no longer assign the approval list to an ECO.

3. Enter a sequence for the approver.  This number indicates the
sequence of the approver for the ECO.  Engineering uses this for
information purposes only.

4. Enter an employee name for the approver.
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5. Enter a date for this approver on this approval list.  As of this date,
the approver is no longer notified when an ECO requires their
approval.

See Also

ECO Approval Statuses: page 2 – 59

Workflow for ECO Approvals: page 2 – 11

Roles Window, Oracle Workflow Guide

Viewing ECO Approval Status: page 2 – 26

Engineering Change Order Approval Lists Report: page 4 – 2
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Starting the AutoImplement Manager

The AutoImplement Manager runs at the specified dates and times and
automatically implements items whose schedule dates occur on or
before the current date.  Engineering change orders or revised items
whose status is Scheduled are automatically implemented.

� To start the AutoImplement Manager:

1. Navigate to the Start AutoImplement Manager window.  See:
Submitting a Request, Oracle Applications User’s Guide.

2. Enter or select the Automatic Engineering Change Order
Implementation program.

3. Enter the dates and times when to run the ECO auto implement
process.

See Also

Changing the ECO Status: page 2 – 29
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Engineering Profile Options and Security Functions

During implementation, the system administrator sets up and
maintains security functions and profile options.

Security Functions

Engineering Change Orders: Approvals
(ENG_ENGFDECN_APPROVAL)

Determines whether an Engineering Change Order (ECO) approval
Workflow process can be submitted or aborted.

Engineering Change Orders: Cancel (ENG_ENGFDECN_CANCEL)

Determines whether ECOs can be cancelled.

Engineering Change Orders: Implement
(ENG_ENGFDECN_IMPLEMENT)

Determines whether ECOs can be implemented.

Engineering Change Orders: Release (ENG_ENGFDECN_RELEASE)

Determines whether ECOs can be released.

Engineering Change Orders: Reschedule
(ENG_ENGFDECN_RESCHEDULE)

Determines whether ECOs can be rescheduled.

Engineering Change Orders: Schedule
(ENG_ENGFDECN_SCHEDULE)

Determines whether ECOs can be scheduled.

Engineering Change Orders: Update (ENG_ENGFDECN_UPDATE)

Determines whether ECOs can be updated.

Engineering Items: Delete (ENG_INVIDITM_DELETE)

Determines whether engineering items can be deleted from the Bills of
Material or Routings windows.

Engineering Items: Revisions (ENG_INVIDITM_REVISIONS)

Determines whether revisions for engineering items can be updated.
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Engineering Items: Transfer (ENG_INVIDITM_TRANSFER)

Determines whether engineering items can be transferred to
manufacturing.

Profile Option Settings

You can set or view the following profile options in Oracle Order
Entry/Shipping.  The table also includes some profile options from
other applications that are used by Engineering.

User System Administrator Requirements

Profile Option
User User Resp App Site Required?

Default
Value

ENG: Change Order
Autonumbering – System
Administrator Access

– � � � � Required No

ENG: ECO Department – � � � � Optional No

ENG: ECO Revision
Warning

– 0 0 0 � Optional No

ENG: Engineering Item
Change Order Access

– � � � � Optional Yes

ENG: Mandatory ECO
Departments

– 0 0 0 � Optional No

ENG: Model Item Change
Order Access

– � � � � Optional Yes

ENG: Planning Item Change
Order Access

– � � � � Optional No

�

–

0

You can update the profile option.

You can view the profile option value but you cannot change it.

You cannot view or change the profile option value.

Key
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RequirementsSystem AdministratorUser

Profile Option Default
ValueRequired?SiteAppRespUserUser

Profile Option

ENG: Require Revised Item
New Revision

– 0 0 � � Optional No

ENG: Standard Item Change
Order Access

– � � � � Optional Yes

Key

�

–

0

You can update the profile option.

You can view the profile option value but you cannot change it.

You cannot view or change the profile option value.

Profile Options

ENG: Change Order Autonumbering – System Administrator Access

Indicate whether you can define ECO autonumbering for all users or
for yourself only.

ENG: ECO Department

Indicate the default department Engineering uses when you define an
ECO.  An ECO department is the department currently responsible for
an ECO.  It restricts departments from updating ECOs for which they
are not responsible.

ENG: ECO Revision Warning

Indicate whether to raise a warning but still implement ECO revisions
with pending lower level revisions (Yes), or to raise an error and not
perform the implementation (No or blank).  A blank (or “null”) value is
equivalent to No.

ENG: Engineering Item Change Order Access

Indicate whether you can revise engineering items on ECOs.

ENG: Mandatory ECO Departments

Indicate whether it is mandatory to assign a department to each ECO
so you can enforce a security policy.

ENG: Model Item Change Order Access

Indicate whether you can revise model and option class items on ECOs.
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ENG: Planning Item Change Order Access

Indicate whether you can revise planning items on ECOs.

ENG: Require Revised Item New Revision

Indicate whether it is mandatory to assign a new revision to revised
items on ECOs.  A blank (or “null”) value is equivalent to No.

ENG:Standard Item Change Order Access

Indicate whether you can revise standard items on ECOs.

See Also

Overview of Function Security, Oracle Appliactions System
Administrator’s Guide

Implementing Function Security, Oracle Appliactions System
Administrator’s Guide

Setting Your Personal User Profile, Oracle Applications User’s Guide

Common User Profile Options, Oracle Applications User’s Guide

Profile Options in Oracle Application Object Library, Oracle Applications
User’s Guide
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Engineering Change
Orders

his chapter tells you everything you need to know to use
engineering change orders, including:

• Overview of Engineering Change Orders: page 2 – 2

• Defining Engineering Change Orders: page 2 – 22

• Mass Changing ECOs: page 2 – 43

• Implementing ECOs: page 2 – 44

• Cancelling ECOs and Revised Items: page 2 – 47

• Viewing ECO Schedules: page 2 – 49

• Use–up ECOs: page 2 – 50

• Unreleased Item Revisions in Oracle Work in Process: page 2 – 52

• Purging ECOs: page 2 – 57

• Engineering Change Orders Field Reference: page 2 – 58
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Overview of Engineering Change Orders

Engineering Change Orders (ECOs) enable you to control new item
revisions and bill of material changes.  With one ECO, you can group
several bill of material changes that affect one or more bills.

You can define ECOs for all types of items and bills, including:

• manufacturing and engineering items

• bills and their components

• planning, model, option class, and standard items

• primary and alternate bills of material

An ECO specifies changes to one or more items that are logically
related to each other, such as a new product introduction.  Each ECO
specifies changes for one or more revised items and each revised item
can have one or more revised components.

Depending on the ECO type, an ECO can update manufacturing bills
only or both manufacturing and engineering bills.  If the ECO type can
only update manufacturing bills, you cannot revise engineering items.

You can add either engineering or manufacturing items as components
on engineering bills.  However, you can only add manufacturing items
as components on manufacturing bills.

Revised Items

Revised items can be either items or bills.  If a revised item is a bill, you
can change the item revision and component information (revised
components).  If a revised item defines a new bill, you can create
revised components by copying an existing bill.

Engineering changes can be defined by date and or model/unit number
effectivity.  You should assign an effective date and model / unit
number for each revised item on an ECO.  Engineering uses this
information to implement the ECO and to identify past due ECOs.
Each time you change a revised item’s effective date, Engineering adds
an entry to list effective date changes.  You can also specify an early
effective date that determines the earliest date that you can manually
implement a change.  If you do not enter an early effective date, you
can manually implement the change at any time.  You can reschedule
an ECO by entering a new effective date.  A date effective revised item
can only have date effective revised components.
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A unit effective revised item can have both unit and/or date effective
components.  All unit effective revised items must have a from end
item unit number specified, if the effectivity profile is set to Unit
effectivity.  The from end item unit number will be null and
non–updatable for date effective revised items.  The to end item unit
number field will also be null and non–updatable for revised
components of date effective revised items  If you are implementing a
ECO for a unit effective component, the from unit number needs to be
specified in the revised item block and the to unit number needs to be
specified in the revised components block.

Note:  There are two conditions under which revised items are not
implemented: if the early effective date is greater than the current
date, and if the user does not have access to the item type of the
revised item.  For example, if the revised item is a model item and
the user does not have access to model items, the revised item is
not implemented.  The same is true for option class, planning, and
standard items.

You can control whether Oracle Master Scheduling/MRP plans your
proposed changes before implementation.  If you have engineering
changes that are firm, but whose effective date is in the future, you may
want planning to consider those changes.  You can choose to plan
changes on any pending ECO regardless of the ECO status.  Changes to
the ECO status or the revised item status will automatically update the
MRP active attribute.  However, you can always manually set the MRP
active attribute as desired.

For each revised item, you can also specify whether Engineering should
update work in process material requirements.  When you implement
such an ECO revised item, Engineering automatically re–explodes and
updates the bill of material for all unreleased jobs and repetitive
schedules for that item.

Engineering also updates repetitive schedules with statuses of
Released, Complete, or On hold accordingly.

Revised Components

You can add, change, or delete bill of material components and their
attributes.  The components and their attributes have the same
restrictions as when you define a bill using Oracle Bills of Material.  For
example, you can only add components that are standard, model, or
option class items for revised items that are model items.
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Revisions

When you enter a revised item on an ECO, Engineering displays the
current and latest revision of the item.  The latest revision could be
higher than the current revision if the latest revision is on a pending
ECO.

Engineering uses the ENG: Require Revised Item New Revision to
control new item revisions for each engineering change.  If engineering
changes always correspond to new item revisions, set this profile
option to Yes.  Doing so will force a new item revision for all revised
items on an ECO.  When you require new item revisions, you can track
all engineering changes to an item by revision.  For example, you can
group related design changes on an ECO and roll revisions for each
item to reflect the latest design.

If you define related ECOs at different times, set this profile option to
No so you increment the revision only once.  You can then define one
ECO to change the revised item revision and other ECOs that do not
change the item revision.  Minor changes that do not affect form, fit, or
function of an item may not require new revisions.

See Also

Implementation of ECOs on Jobs and Schedules: page 2 – 52

Bill / Component Validation Rules, Oracle Bills of Material User’s Guide

Item and Routing Revisions, Oracle Bills of Material User’s Guide

ECO Revised Item Statuses: page 2 – 58

ECO Access Control

Oracle Engineering controls the access to ECOs and the changes you
can specify on them using profile options, security functions, item
types, ECO types, and ECO departments.

ECO Types

For each ECO type, you specify if it can update engineering items.
Only users whose profile option indicates they can update engineering
items can choose ECO types that update engineering items.



2 – 5Engineering Change Orders

Item Types

Oracle Bills of Material and Engineering use two item master attributes
to control access to items and to determine the types of items that can
be on a bill: BOM Item Type and Engineering Item.

The BOM Item Type item master field divides items into four major
types: planning items, model items, option class items, and standard
items.

User Profile Options

User profile options control the types of items you can revise on an
ECO.  You can specify whether a user or responsibility can revise
model and option class items, planning items, standard items, or
engineering items on ECOs.

Engineering uses the following four profile options to control the types
of items you can change on an ECO:

• ENG: Engineering Item Change Order Access (engineering
items)

• ENG: Model Item Change Order Access (model and option class
items)

• ENG: Planning Item Change Order Access (planning items)

• ENG: Standard Item Change Order Access (standard items)

Engineering enforces security for engineering items by only letting
users that are allowed to update engineering items choose ECO types
that update engineering items.  In addition, to update engineering bills
of material for manufacturing items, you must choose ECO types that
update engineering items.

Each time you try to add a revised item to an ECO, Engineering checks
to see if you can update that item based on its BOM Item Type and
your profile options.

For example, you might define several ECO types that can update
manufacturing items, and only define one type that can update
engineering items.

You might also specify profile options to control access to BOM item
types by user, as shown in the following example:
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User ECO Department

Standard
Item
Access

Planning
Item
Access

Model /
Option
Class Item
Access

Engineering
Item Access

Joe Product Engineering Yes No No Yes

Mary Mfg. Engineering Yes No Yes No

Fred Customer Service No No Yes No

Sue Material Planning No Yes No No

Dave Production Yes No Yes No

Table 2 – 1  User Profile Options 

In the example, Joe can create ECOs that update standard items.  Mary
can create ECOs that update manufacturing standard items and model
/ option class items.  But Mary is not allowed to update engineering
items.

Profile Settings for Changing Bills Only With ECOs

To limit user’s access to bills of material only through ECOs, set the
following Bills of Material profile options to No:

• BOM: Standard Item Access

• BOM: Planning Item Access

• BOM: Model Item Access

And the following Engineering profile options to Yes:

• ENG: Standard Item Change Order Access

• ENG: Planning Item Change Order Access

• ENG: Model Item Change Order Access

• ENG: Engineering Item Change Order Access.

Profile Settings for Changing Bills With or Without ECOs

With the same seven profile options listed above all set to Yes, bills can
be changed with or without ECOs.

ECO Departments

You can assign users to departments and secure each ECO to a
department so that only users in that department can access the ECO.
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If you do not specify a department for an ECO, any user can access it.
If you do not assign a user to a department, they can access all ECOs.
Setting the ENG: Mandatory ECO Departments to Yes requires you to
specify a responsible department on every ECO.

You can update the responsible department as you release an ECO
from the current ECO department.  For example, if Product
Engineering releases an ECO to Manufacturing Engineering, they can
reassign the responsible department so it becomes visible and
updatable to users assigned to the Manufacturing Engineering ECO
department.
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See Also

Engineering Profile Options and Security Functions: page 1 – 20

Oracle Bills of Material Profile Options, Oracle Bills of Material User’s
Guide

Defining ECO Types: page 1 – 9

Access Control by Item Type, Oracle Bills of Material User’s Guide

Overview of Engineering Prototype Environment: page 3 – 2

ECO Life Cycle

Engineering uses two ECO status fields to control the ECO life cycle:
ECO Status and ECO Approval Status.  See: ECO Statuses: page 2 – 58.

You can change an ECO’s status.  You can open, hold, release, schedule,
implement, or cancel a revised item or an ECO.  Engineering does not
let you set the ECO Status field to Implemented or Scheduled if the
approval status has not been set to Approved.

The following example illustrates a typical ECO life cycle:

Sequence Action
Approval
Status ECO Department

Start creating new ECO Hold Not Submitted
for Approval

Mfg. Engineering

Complete data entry Open Not Submitted
for Approval

Mfg. Engineering

Submit approval process Approval
Requested

Mfg. Engineering

Oracle Workflow controls
approval process

Approval
Requested

Mfg. Engineering

Approve and release Released Approved Production

Production updates date Scheduled Production

Effective date arrives Implemented Production

Table 2 – 2  ECO Status Flow
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See Also

Creating an ECO: page 2 – 23

Viewing ECO Approval Status: page 2 – 26

Implementing ECOs: page 2 – 44

ECO Approvals

ECOs can be approved in three ways, two of which require an approval
process.  The third requires no approval process.

First, the ECO, based on the ECO type in combination with the ECO
priority, can be associated with an Oracle Workflow process.  Once
approval is granted, Workflow automatically updates the approval
status.

Second, a simple approval list can be used, which sends an Oracle Alert
to all those listed requesting their approval.  Once approved, you must
manually update the approval status.  This approval option does not
require an Oracle Workflow process.

The third method is to use neither of the above; the ECO needs no
formal approval process and is given the status of Approved.

If the ECO is associated with an Oracle Workflow process, only
Workflow may set the status to Approved.  If the ECO has an approval
list, you must set the status to Approved manually after the ECO has
been approved by the appropriate member(s) on the approval list.

If neither is used, the ECO is set to Approved but can be manually
rejected.

The following table describes the conditions under which the different
approval statuses can be used:
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Condition Valid Approval Statuses

No approval list / no
workflow approval process

Approved (default), Rejected

Approval list Not Submitted for Approval (default), Ready to Approve
(Oracle Alert fires), Approval Requested, Rejected,
Approved

Workflow approval process Not Submitted for Approval, Approval Requested,
Rejected, Approved, Processing Error

Table 2 – 3    (Page 1 of 1) 

See Also

Workflow for ECO Approvals: page 2 – 11

ECO Approval Statuses: page 2 – 59
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Workflow for ECO Approvals

Most organizations have some form of approval process before
engineering change orders (ECOs) are implemented.  By using Oracle
Workflow, the approval process can be customized to meet each
organization’s needs.

Business rules for the approval of ECOs are defined in a workflow
process.  For each ECO, Workflow manages adherence to these
business rules, including:

• submission of the completed ECO for approval via Workflow

• enforced approval process for an ECO type

• communication of messages via Notification Viewer, electronic
mail, or web browser

• review of ECO from Notification Viewer

• automatic processing of user responses and update of system

• workflow status indicator for ECOs

• usage of current approval lists (roles) in the workflow process.

Once the ECO is created, Workflow takes over processing.

When Workflow is in control of the approval process, the ECO
approval status is set to Approval Requested.  Before the approval
status is changed, the workflow approval process can be aborted.

Workflow manages the approval process until the entire approval flow
is complete.  Only then is the ECO approval status updated to either
Approved or Rejected.  If an error occurs during the Workflow
approval process, the approval status is set to Processing Error.

Standard Workflow Process

One workflow process, named “Standard Approval Process,” is
predefined when Engineering is installed, regardless whether the entire
Oracle Workflow product is installed.  If the entire Workflow product is
installed, you can modify this process or create new processes.

If you use the Standard Workflow Process, you must assign a role to
the “Standard Approval Notification” activity.  Otherwise, the process
will fail.

If the Workflow product is not fully installed, you can alter only the
Standard Approval Process.
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ECO Approval List Setup

Workflow can use roles whenever an activity involves several users.
Approval lists defined in Engineering can be used to create roles.  Roles
are made up of either one approval list or one employee previously
defined with the Enter Person window.

The ECO workflow approval process will notify all persons in the role,
regardless if the role is defined using an approval list or an individual
employee.

To approve (or reject) the ECO, approvers must respond to the
notification.  If the approver has an Oracle Applications Object Library
account, they can respond to ECO approval requests using either a web
browser or the Notification Viewer.  If not, the approver can respond
via electronic mail, provided their address is defined in the Enter
Person window.

ECO Types and Priorities Setup

ECO types can be associated with a workflow process.  If you do not
associate an ECO type with a workflow process, there can be no
workflow approval process for ECOs using that ECO type.  If there is
an approval list, the ECO cannot be associated with a process.

ECO types that are associated with a workflow process can optionally
be associated with an ECO priority.  If so, ECOs that use the
type/priority combination are approved via Workflow.  Doing so
enables workflow approval processes to be ranked according to
priority.

ECO Approval

The only user intervention required for a workflow approval process is
for individual approvers to respond to an ECO approval notification.
Once the process is complete, Workflow automatically updates the
ECO approval status.

Customizing the Standard Approval Process

Once you install Oracle Engineering, you can view the Standard
Approval Process in a Process window using Oracle Workflow Builder.



2 – 13Engineering Change Orders

� To Display the Standard Approval Process in Oracle Workflow
Builder

1. Choose Open from the File menu, and connect to the database
where you installed Oracle Engineering.

2. Select the ECO Approval item type.

3. Expand the data source, then the ECO Approval item type branch
within that data source.

4. Expand the Processes branch within ECO Approval then
double–click on the Standard Approval Process activity to display
the diagram of the process in a Process window.

Required Modifications

You must make the following modifications to the Standard Approval
Process before you can use it to initiate a workflow:
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1. Specify an Approval for the ECO Approval Process

• Choose Load Roles From the Database from the File menu.
Select the role you wish to use for an approval.

Note:  A role can represent a person or a group of persons.  You
must have already defined approvers and/or approval lists in
Oracle Engineering.

• Select the Standard Approval Notification activity to view its
properties.

• Enter Constant as the Performer Type.  Select a Performer from
the adjacent list of values.

• Select OK to save your changes.

Optional Modifications

Although you can use the Standard Approval Process as is, you may
wish to customize the process further to accommodate your
organization’s specific needs.

Creating a New Custom Process

You can use the Standard Approval Process for your ECO approvals or
create you own approval process using Oracle Workflow.  You must
have the Oracle Workflow product installed to create your own
approval process.

See Also

Oracle Workflow, Oracle Workflow Guide

Introduction to Oracle Workflow, Oracle Workflow Guide

ECO Approval Process Activities: page 2 – 17

Defining ECO Types: page 1 – 9

Defining ECO Approval Lists: page 1 – 17

Creating an ECO: page 2 – 23

Viewing ECO Approval Status: page 2 – 26
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The ECO Approval Item Type

The ECO Approval process is associated with an item type called ECO
Approval.  This item type represents the domain of all processes and
activities used in the ECO Approval process and used by Oracle
Engineering.

ECO Approval Item Type Attributes:

Display Name Description Type Length

Approval Status ECO Approval Status Text 80

Attribute1 Attribute1 Text 150

Attribute2 Attribute2 Text 150

Attribute3 Attribute3 Text 150

Attribute4 Attribute4 Text 150

Attribute5 Attribute5 Text 150

Attribute6 Attribute6 Text 150

Attribute7 Attribute7 Text 150

Attribute8 Attribute8 Text 150

Attribute9 Attribute9 Text 150

Attribute10 Attribute10 Text 150

Attribute11 Attribute11 Text 150

Attribute12 Attribute12 Text 150

Attribute13 Attribute13 Text 150

Attribute14 Attribute14 Text 150

Attribute15 Attribute15 Text 150

Attribute Category Attribute Category Text 30

ECO Engineering Change Order Text 30

Change Type Change Type Text 10

ECO Dept Code ECO Department Code Text 3

ECO Dept Name ECO Department Name Text 60

ECO Description ECO Description Text 2000

Table 2 – 4    (Page 1 of 2) 
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LengthTypeDescriptionDisplay Name

ECO Status ECO Status Text 80

Estimated Eng Cost Estimated Engineering Cost Number

Estimated Mfg Cost Estimated Manufacturing Cost Number

Full Name Change Requestor Text 240

Initiation Date ECO Initiation Date Date

Organization Code Organization Code Text 3

Organization Name Organization Name Text 60

Org ID Organization ID Number

Priority Code ECO Priority Code Text 10

Reason Code ECO Reason Code Text 10

Rev ID Revision ID Number

Table 2 – 4    (Page 2 of 2) 

Summary of the ECO Approval Process

The ECO Approval process consists of nine unique activities as
displayed in the process diagram.  The ECO Approval workflow begins
when you submit an approval requisition from the ECO form in Oracle
Engineering.  The workflow begins at node 1 with the start activity.  At
node 2, the function gets all required ECO attributes and sets the item
attributes.  The ECO Approval status is changed to Approval
Requested at node 3 and users on the approval list are notified of the
ECO.  If the user approves the ECO, the MRP Active ECO attribute is
set to YES at node 4  and the approval status is set to Approved at node
5.  If the user rejects the ECO, the MRP active attributes is set to NO at
node 7 and the ECO approval status is set to Rejected at node 8.  The
workflow process ends either at node 6 or at node 9 depending on
whether the user approves the ECO.
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ECO Approval Process Activities

This section provides a description of each activity in the process, listed
by the activity’s display name.  The legend for the information
displayed is provided below, immediately followed by a list of
activities.

Start (Node 1)

This is a standard function activity that simply marks the start of the
process.

• Function – WF_STANDARD.NOOP

• Result Type – None

• Required – Yes

• Prerequisite Activities – None

• Item Attributes Set by Function – None

• Item Attributes Retrieved by Function – None
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Get ECO Attributes (Node 2)

This function gets all required ECO attributes and sets the item
attributes.

• Function –
ENG_WORKFLOW_API_PKG.GET_ECO_ATTRIBUTES

• Result Type – None

• Required – Yes

• Prerequisite Activities – None

• Item Attibutes Set by Function – CHANGE_NOTICE

– ECO_DESCRIPTION

– ECO_STATUS

– INITIATION_DATE

– PRIORITY_CODE

– REASON_CODE

– ESTIMATED_ENG_COST

– ESTIMATED_MFG_COST

– ATTRIBUTE_CATEGORY

– ATTRIBUTE1

– ATTRIBUTE2

– ATTRIBUTE3

– ATTRIBUTE4

– ATTRIBUTE5

– ATTRIBUTE6

– ATTRIBUTE7

– ATTRIBUTE8

– ATTRIBUTE9

– ATTRIBUTE10

– ATTRIBUTE11

– ATTRIBUTE12

– ATTRIBUTE13

– ATTRIBUTE14
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– ATTRIBUTE15

– APPROVAL_STATUS

– ORGANIZATION_CODE

– ORGANIZATION_NAME

– FULL_NAME

– CHANGE_TYPE

– ECO_DEPT_NAME

– ECO_DEPT_CODE

• Item Attibutes Retrieved by Function – None

Standard Approval Notification (Node 3)

This is a standard approval notification that requests approval from
users on the approval list.

• Message – Standard Approval Message

• Result Type – ECO Approval

• Required – Yes

• Prerequisite Activities – Standard Approval Message

• Expand Roles – No

• Notification Function – None

Set MRP to Active (Node 4)

After the user has approved the ECO, this function sets the MRP Active
attribute to on for revised items with status of Open and Scheduled.
This can be used to create MRP demand when the ECO’s approval
status is updated to Approved.

• Function – ENG_WORKFLOW_API_PKG.SET_MRP_ACTIVE

• Result Type – None

• Required – Yes

• Prerequisite Activities – Standard Approval Notification

• Item Attributes Set by Function – None

• Item Attributes Retrieved by Function – None
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Approve ECO (Node 5)

This function sets the status of the ECO to Approved.

• Function – ENG_WORKFLOW_API_PKG.APPROVE_ECO

• Result Type – None

• Required – No

• Prerequisite Activities – Standard Approval Notification

• Item Attributes Set by Function – None

• Item Attributes Retrieved by Function – None

End (Approve)  (Node 6)

This function ends the ECO approval process with a status of
Approved.

• Function – WF_STANDARD.NOOP

• Result Type – None

• Required – No

• Prerequisite Activities – None

• Item Attributes Set by Function – None

• Item Attributes Retrieved by Function – None

Set MRP Inactive  (Node 7)

After the user has rejected the ECO, this function sets the MRP Active
attributes to off for revised items with status of Open and Scheduled.

• Function – ENG_WORKFLOW_API_PKG.SET_MRP_INACTIVE

• Result Type – None

• Required – Yes

• Prerequisite Activities – Standard Approval Notification

• Item Attributes Set by Function – None

• Item Attributes Retrieved by Function – None

Reject ECO  (Node 8)

This function sets the status of the ECO to Rejected.

• Function – ENG_WORKFLOW_API_PKG.REJECT_ECO
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• Result Type – None

• Required – No

• Prerequisite Activities – Standard Approval Notification

• Item Attributes Set by Function – None

• Item Attributes Retrieved by Function – None

End (Reject) (Node 9)

This function ends the ECO approval process with a status of Rejected.

• Function – WF_STANDARD.NOOP

• Result Type – None

• Required – No

• Prerequisite Activities – None

• Item Attributes Set by Function – None

• Item Attributes Retrieved by Function – None

See Also

Oracle Workflow, Oracle Workflow Guide
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Defining Engineering Change Orders

An engineering change order (ECO) controls item revisions and bill of
material changes.  ECOs specify changes to one or more items and each
of these items can have one or more revised components.

Prerequisites

❑ To update ECOs, the Engineering Change Orders: Update security
function must be included as part of the responsibility.

� To define Engineering Change Orders:

1. Navigate to the Engineering Change Orders window.

2. Create the ECO.  See: Creating an ECO: page 2 – 23.

3. Assign an ECO approval list and status.  See: Viewing ECO
Approval Status: page 2 – 26.

4. Define implementation costs.  See: Defining Implementation Costs:
page 2 – 31.

5. Define an ECO revision.  See: Defining an ECO Revision: page
2 – 31.

6. Define revised items.  See: Defining ECO Revised Items: page
2 – 32.

7. Review ECO scheduling.  See: Viewing ECO Schedule History:
page 2 – 35.

8. Review item revisions.  See: Viewing Item Revisions: page 2 – 40.

9. Define revised components.  See: Defining Revised Components:
page 2 – 37.

10. Review substitute components and reference designators.  See:
Assigning or Deleting Substitute Components: page 2 – 40 and
Assigning Reference Designators: page 2 – 41.

11. Optionally, attach files to ECOs.  See: Attaching Files to ECOs: page
2 – 42.

12. Submit the ECO for approval or set approval status to Ready to
Approve.

See Also

Rescheduling an ECO or Revised Items: page 2 – 28
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Changing the ECO Status: page 2 – 29

Implementing ECOs: page 2 – 44

Engineering Change Order Detail Report: page 4 – 3

Creating an ECO   

An ECO’s approval status must be Approved before the ECO can be
implemented.

Note:  If the approval status is Approval Requested, you cannot
modify the ECO.  If the approval status is Approved and the ECO
is modified, the approval status will be set back to Not Submitted
for Approval.

When ECO types are defined, they can optionally be associated with a
priority as they are being associated with an Oracle Workflow process.
When creating the ECO, if the selected ECO type / priority
combination matches a defined ECO type/priority combination, the
associated workflow process defaults.  The approval status is set to Not
Submitted for Approval until the Submit button is chosen.  If there is
no match between entered values and existing ECO type / priority
combinations, the approval status is set to Approved and you can enter
an approval list.

Prerequisites

❑ Define at least one ECO type.
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� To create an ECO:

1. Navigate to the Engineering Change Orders window.

2. Enter an alphanumeric ECO identifier.  If you use ECO
autonumbering, the next identifier is defaulted.

3. Enter or select an ECO type.

You can only select ECO types that can revise engineering items
and bills if the ENG: Engineering Item Change Order Access profile
option is set to Yes.  If the selected ECO type updates engineering
and manufacturing items and bills, any new bills defined on the
ECO are engineering bills.

4. Optionally, enter the requestor of the ECO.

5. Optionally, enter the ECO department responsible for the ECO.
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This can be used to transition the ECO from one department to
another, for example, from manufacturing engineering to
operations.  For new ECOs, the default is derived from the ENG:
ECO Department profile option.

If you specify that each ECO must have an ECO department, that
is, the ENG: Mandatory ECO Departments profile option is set to
Yes, then you must specify a responsible department.

Access to ECOs by ECO department is as follows:

• You can only view and update ECOs with the same ECO
department as your ENG: ECO Department profile option.

• If you do not have a value for the profile option ENG: ECO
Department, you can query and update any ECO.

• Any user can query and update ECOs with no department
reference.

6. Optionally, enter a reason for the engineering change.

7. Optionally, enter or select a priority for the ECO.

Note:  If the ECO type and the priority combination are associated
with an Oracle Workflow process, you cannot use an approval list.

8. If a workflow process is not associated with the ECO, you can enter
an approval list.  If you do not enter an approval list, the ECO
approval status defaults to Approved without any kind of approval
process.

9. Choose the ECO Revisions button to define ECO revisions.  See:
Defining an ECO Revision: page 2 – 31.

10. Choose the Revised Items button to define revised items.  See:
Defining ECO Revised Items: page 2 – 32.

11. Select the ECO status from the Tools menu.  See: ECO Statuses:
page 2 – 58.

If the ECO status is Implement or Cancelled, the date of either
status change is displayed.

12. If a workflow process is associated with the ECO, choose the
Submit button to start the process.

13. If a workflow process is associated with an ECO, choose the
Approvals button to view the approval status of the ECO.

If you are using an approval list, change the approval status to
Ready to Approve.  Doing so sends the Alert.
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See Also

Defining ECO Types: page 1 – 9

Viewing ECO Approval Status: page 2 – 26

Changing the ECO Status: page 2 – 29

Implementing ECOs: page 2 – 44

Defining ECO Autonumbering: page 1 – 11

MRP Planning for ECOs: page 2 – 51

Unreleased Item Revisions in Oracle Work in Process: page 2 – 52

Implementation of ECOs on Discrete Jobs and Repetitive Schedules:
page 2 – 52

Engineering Profile Options and Security Functions: page 1 – 20

Viewing ECO Approval Status   

If an approval list is used, the approval status can only be changed
manually, pending formal approval from a list member.

If a workflow process is associated with the ECO (based on the ECO
type / priority combination), the approval status is changed
automatically.

If neither a list nor a process is used, you must manually select either
Approved or Rejected.

� To view approval dates:

� Select View Dates from the Tools menu.  The approval request date,
the approved date (if applicable), and the days to approve are
displayed for reference.
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� To view workflow approval status:

1. Navigate to the Approval History window.  Do this by choosing
the Approvals button from the Engineering Change Orders
window.

The process names and the submit dates are displayed for
reference.

2. Choose the Status button to view the status of an ECO approval
process.

See Also

ECO Approval Statuses: page 2 – 59

Workflow for ECO Approvals: page 2 – 11
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Rescheduling an ECO or Revised Items 

You can reschedule ECOs or ECO revised items unless their status is
Cancelled or Implemented.

Attention:  Rescheduling does not change the ECO or revised item
status, only the dates.

Prerequisites

❑ To reschedule an ECO, the Engineering Change Orders: Reschedule
security function must be included as part of the responsibility.

❑ The approval status must be set to Approved before the ECO or
any revised items can be scheduled or rescheduled.

� To reschedule an ECO or Revised Items:

1. Choose Reschedule from the Tools menu from either the
Engineering Change Orders window or the Revised Items window.

2. Do one of the following:

• If you are rescheduling an ECO, select an effective date from the
calendar.

• If you are rescheduling revised items, select a use–up date.

3. Enter the requestor of the rescheduled ECO.

4. Choose OK to save your work.

If you entered this window from the Engineering Change Orders
window, choosing OK will reschedule all pending revised items
(those with the status of Open, Hold, Schedule, or Release) for this
ECO.

If you entered this window from the Revised Items window, this
will reschedule only the selected revised item.

See Also

Overview of Function Security, Oracle Appliactions System
Administrator’s Guide

Implementing Function Security, Oracle Appliactions System
Administrator’s Guide
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Changing the ECO Status

You can change the ECO status and the ECO revised item’s status to
Open, Hold, Release, Schedule, Implement, or Cancel.

An ECO’s approval status must be Approved before the ECO can be
implemented.
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The following table describes the conditions regarding Workflow under
which the status can be changed:

Status Without
Workflow

With Workflow:
Before Approval

With Workflow:
After Approval

With Workflow:
Approval in
Process

Open Yes Yes Yes No

Hold Yes Yes Yes No

Released Yes Yes Yes No

Scheduled Yes No No No

Rescheduled Yes Yes Yes No

Cancel Yes Yes Yes No

Implement Yes No Yes No

Table 2 – 5  

Prerequisites

❑ To change the ECO status, the appropriate security function(s)
must be included as part of the responsibility.

� To change the ECO status:

1. Navigate to the Engineering Change Orders window.

2. From the Tools menu, choose the status (Open, Hold, Release,
Schedule, Implement, or Cancel).  See: ECO Statuses: page 2 – 58.

3. If you are cancelling the ECO, select the Cancel Comments pop list
to enter comments.

4. Save your work.

See Also

Implementing ECOs: page 2 – 44

Starting the AutoImplement Manager: page 1 – 19

Cancelling ECOs and Revised Items: page 2 – 47

Engineering Profile Options and Security Functions: page 1 – 20
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Defining Implementation Costs 

Estimate the implementation costs to engineering and to manufacturing
of the ECO.  Oracle Engineering uses this information for reference
purposes only.

� To define manufacturing and engineering costs:

1. Choose Enter Costs from the Tools menu.

2. Enter a cost for engineering

3. Enter a cost for manufacturing.

Defining an ECO Revision  

� To define an ECO revision:

1. Navigate to the ECO Revisions window.  Do this by choosing the
ECO Revisions button from the Engineering Change Orders
window.

2. Enter a revision for the ECO.

The date that you entered the ECO is displayed for reference.
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3. Save your work.

Defining ECO Revised Items  
Each ECO can list one or more revised items whose form, fit, or
function needs revision.

Any revised item can have an associated bill of material.  You can
create a bill for a revised item (if one does not exist) by copying it from
another bill or by adding components to it.

� To define revised items:

1. Navigate to the Revised Items window.  Do this by choosing the
Revised Items button from the Engineering Change Orders
window.

2. Enter or select an item to change with this ECO.

Note:  You can create a bill for the item (if one does not exist) by
choosing the Components button and adding components in the
Revised Components window.
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3. Optionally, enter an alternate for the item.  You can create or
update alternate bills using an ECO.

4. Optionally, enter a new revision for the revised item.

This must be greater than or equal to the current revision.  If you
create or update an alternate bill of material, you cannot assign a
new item revision.

You must enter a new revision for the revised item if you set the
ENG: Require Revised Item New Revision profile option to Yes.

5. Enter an effective date for the item and component changes.

This date is used to implement the revised item and identify past
due revised items.

If you select a use–up date for this item and its components, a
record is created that indicates that this revised item is based on the
use–up date of the item.  If the MRP planning process computes a
new use–up date before this revised item is implemented,
Engineering automatically sends an alert to the planner.

6. Choose a status for the ECO revised item from the Tools menu.
See: ECO Revised Item Statuses: page 2 – 58.

Note:  You can set the revised item status to Hold, Released,
Implemented, or Cancelled only if the ECO status is Open.
Otherwise, the revised item status defaults from the ECO status.

If the ECO has a Workflow process and the item or its components
are changed, the revised item’s status is changed from Scheduled to
Open and the approval status is changed to Not Submitted for
Approval.

7. Indicate whether the revised item is MRP Active, that included in
the planning process.  The default is No if the Status is Hold; Yes if
the Status is Open, Release, or Schedule.

If the ECO lists engineering changes and has an effective date in the
future, you may want the planning process to consider those
changes.

8. Open the Item Details tabbed region and view the description and
the user–defined item type for that item.

9. Optionally, open the Dates tabbed region and enter the Early
Effective date.  This is the earliest date you can manually
implement the revised item.
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If applicable, the Cancelled date for the changes of the revised item
and its components, or the Implemented date for the revised item
is displayed.

The Implemented Immediately check box, if enabled, indicates the
item was implemented manually from the Tools menu.  If disabled,
the item is scheduled for automatic implementation.

10. Open the Use Up Details tabbed region and do the following:

• If not already selected, enter the item whose use–up date is tied
to the revised item effective date.  The use–up item can be the
revised item itself or a component of the revised item.

• View the use–up item associated with the use–up date selected
as the effective date.

• View the name of the MRP plan to use for determining item
use–up dates.

11. Open the Work in Process tabbed region and indicate whether to
update WIP requirements for unreleased jobs or schedules when
the revised item is implemented.

12. Select a disposition for inventory and work in process inventory
affected by the ECO.  See: Disposition: page 2 – 59.

13. Open the Cancel Details tabbed region to view the cancellation date
and cancel comments.

14. Choose the History button to view revised item effective date
history and track schedule changes to the revised item.  Choose the
Revisions button to view item revisions.  Choose the Components
button to add, change, or disable components.

See Also

Viewing ECO Schedule History: page 2 – 35

Defining Revised Components: page 2 – 37

Viewing Item Revisions: page 2 – 40

Use Up ECOs: page 2 – 50
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Viewing ECO Schedule History 

View revised item effective date history and track schedule changes to
revised items.

� To view ECO schedule history:

1. Navigate to the History window.  Do this by choosing the History
button from the Revised Items window.

A history of all previous effective dates and their entry date is
listed for the revised item.
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2. View the employee who initiated the change to the effective date
and any comments describing the change to the effective date.

See Also

Engineering Change Order Detail Report: page 4 – 3
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Defining Revised Components  
Enter and update change information for a revised item’s components.

� To define revised components:

1. Navigate to the Revised Components window.  Do this by choosing
the Components button from the Revised Items window.

2. Enter or select an action to take:

Add:  Add a component to the revised item’s bill of material.  If a
bill does not already exist, adding components creates one.

Change:  Change usage information for the component of the
revised item’s bill.

Disable:  Disable the component from the revised item’s bill.

3. Enter a component on the bill.
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4. Do the following:

• If you are changing component information, enter the old
operation sequence where the component is currently assigned.

• If you are changing the component’s operation sequence, enter a
new operation sequence (from the routing) for the component of
the revised item.  The default is 1 for components being added
where no routing exists.

• Enter the item sequence of the item on the bill of material.  The
default is the next highest item sequence.

• Enter the component quantity used by this particular revised
item.  For components you are changing the default is the
quantity used by the revised item, 0 for components you are
deleting, and 1 for components you are adding.

• For components you are adding or changing, enter an inactive
date for the revised component.

5. Review the item’s description, revision, and whether it is an
engineering item in the Item Details tabbed region.

6. Open the Component Details tabbed region and do the following:

• Enter the planning percent for optional components on model
and option class bills, and all components on planning bills.
Oracle Master Scheduling/MRP uses planning percentages for
planning bill explosions.  You can enter quantities over 100
percent to overplan.  See: Planning Percent, Oracle Bills of
Material User’s Guide.

• Enter a component yield factor.  You cannot enter component
yield for an option class item or for any components of a
planning bill.  The default is 1, indicating 100% yield.  See: Yield,
Oracle Bills of Material User’s Guide.

• Indicate whether to include the cost of this component in the cost
of its parent item for the cost rollup.

• View the component item type and status.

7. Open the Material Control tabbed region and select a supply type,
a subinventory, and a locator.  See: Supply Type, Oracle Bills of
Material User’s Guide and Subinventory and Locator, Oracle Bills of
Material User’s Guide.

8. Open the Order Entry tabbed region and do the following:

• Indicate whether to Check ATP.  See: Check ATP, Oracle Bills of
Material User’s Guide.
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• Indicate whether the component is optional and mutually
exclusive.  See: Mutually Exclusive and Optional, Oracle Bills of
Material User’s Guide.

• For optional components, enter the minimum and maximum
sales order quantities.  See: Minimum and Maximum Quantities,
Oracle Bills of Material User’s Guide.

• Select a basis.  See: Basis, Oracle Bills of Material User’s Guide.

9. Open the Shipping tabbed region and indicate whether the
component should be listed on shipping documents, required to
ship, or required for revenue.  See: Shipping Details, Oracle Bills of
Material User’s Guide.

10. If the component is cancelled, open the Cancel Details tabbed
region.  Once the component is cancelled, you can no longer update
any information about the revised component on this ECO.

Note:  You can cancel revised components by choosing Cancel from
the Tools menu.

11. Choose the Substitutes button to open the Substitute Components
window.  Choose the Designators button to open the Reference
Designators window.

See Also

Assigning Reference Designators: page 2 – 41

Assigning or Deleting Substitute Components: page 2 – 40

Item and Operation Sequence, Oracle Bills of Material User’s Guide

Effective Date Fields, Oracle Bills of Material User’s Guide
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Viewing Item Revisions

� To view item revisions:

1. Navigate to the Item Revisions window.  Do this by choosing the
Revisions button from the Revised Items window.

2. Review the displayed information:

The revision, the effective date and time, the implementation date,
the initiation date, and the ECO are displayed for information
purposes.

Assigning or Deleting Substitute Components  

Assign or delete suggested substitute items for the revised component.
You can assign any number of substitute items to each bill component
and you can assign the same substitute item to more than one
component.
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� To assign or delete substitute components:

1. Navigate to the Substitute Components window.  Do this by
choosing the Substitutes button from the Revised Components
window.

2. Enter an action: add a substitute item to, or delete a substitute item
from the revised component.

3. Enter or select a substitute item for the revised component.  This
must be a manufacturing item.

4. Enter the quantity of the substitute item needed to replace the full
component quantity.

This can differ from the bill usage quantity of the component.  The
default is the usage quantity of the component.

Assigning Reference Designators  

� To assign reference designators to the revised component:

1. Navigate to the Reference Designators window.  Do this by
choosing the Designators button from the Revised Components
window.

2. Indicate whether to relate component quantity to the number of
reference designators.

Off:  Assign any number of reference designators to each
component (the default).  The number of reference designators is
independent of the component quantity.  With Quantity Related
unchecked, if the usage quantity of the component is four, you
could, for example, define six or more reference designators.

On:  Use one reference designator per usage of the component.  The
component usage quantity must be a positive integer in order for
you to use this option.  When the bill requires a quantity of four of
a given component, you assign four reference designators to that
component, one for each usage.

The number of reference designators implemented for the revised
component is displayed.  This value is 0 until the ECO is
implemented.

Also, the total number of reference designators currently defined
for the revised component is displayed.
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3. Select an action: add to or delete a range of reference designators
from the revised component.

Engineering enables you to view a prefix, suffix, and number range
to assign to a sequence of reference designators.

See Also

Creating Reference Designators, Oracle Bills of Material User’s Guide

Attaching Files to ECOs

You can attach text and files, such as spreadsheets, graphics, and OLE
objects to engineering change orders.

For example, an attached file may include comments, such as a
graphical representation of the bill structure or detailed instructions.

� To attach files to ECOs:

� From the Engineering Change Orders window, choose the
Attachments icon.

See Also

Working With Attachments, Oracle Applications User’s Guide
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Mass Changing ECOs

You can define a mass change to add, delete, or replace a component,
alter a component quantity or yield, or change other component
information.  You can mass change all using bills of material or choose
a subset of bills by item range, item category, or item type.

Engineering lets you create an ECO based on your parent item and
component criteria.  A mass change ECO lists all using assemblies that
meet your search criteria as revised items, and assigns all component
changes as revised components.  You can manage and implement each
revised item, or the entire ECO, the same way you maintain revised
items you manually assign to an ECO.

Note:  In Bills of Material, mass changes take place immediately.
However, in Engineering, an ECO is created that must be
implemented to take effect.

� To mass change ECOs:

� Mass change the bills of material as needed.  Be sure to set ECO
options.

See Also

Mass Changing Bills of Material, Oracle Bills of Material User’s Guide

Engineering Profile Options and Security Functions: page 1 – 20
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Implementing ECOs

When you implement an ECO, each revised item’s status is marked as
”implemented”; you can no longer reschedule it.  You can implement
all revised items on an ECO, or implement each revised item on a
different date.  Engineering only lets you implement ECOs that do not
have an approval status of Rejected, or do not have an ECO status of
Hold or Cancelled.  Once you implement an ECO or revised item, you
can no longer make any revised item changes.

You can manually implement revised items on an ECO or you can
automatically implement each revised item on its effective date.
Engineering updates the actual implementation date for each revised
item when it is implemented.  When all of the revised items on an ECO
have been implemented, the ECO is completely implemented and can
be purged.

Engineering implements an ECO over time from the earliest revised
item effective date to the latest revised item effective date.  When you
spread multiple changes across several ECOs, you should ensure that
the effective date ranges for the ECOs do not overlap.  For example, if
you implement changes to a bill of material across many ECOs, you
should make sure that the revised item effective dates do not overlap.
If you implement one change using the current revision, you should
implement all other changes to the current revision before you
implement changes against future revisions.

Attention:  You must implement new revisions in ascending order.
If you implement a later revision for an item on one ECO,
Engineering ensures that you implement any subsequent revisions
for the item in ascending order.

Manual Implementation

For an ECO, you can specify whether to implement all or specific
revised items.  Engineering immediately implements changes to the
revised items you specify and updates all component effective dates to
the current date, regardless of the revised item effective dates.

For example, if you manually implement a revised item that has a
future effective date, Engineering changes the effective date to the
current date and marks the revised item and all revised components as
implemented.
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Automatic Implementation

To AutoImplement a revised item on an ECO, you mark the revised
item status as ’scheduled’ and specify an effective date.  You can
schedule all revised items on an ECO for auto–implementation, or
schedule each revised item individually.  Engineering automatically
implements scheduled changes on their effective dates.

Start the AutoImplement Manager process so Engineering implements
scheduled changes daily.

Prerequisites

❑ To implement an ECO, the Engineering Change Orders: Implement
security function must be included as part of the responsibility.

� To manually implement an ECO:

1. Navigate to the Engineering Change Orders window.

2. Enter or select an ECO to implement.

3. Choose Implement from the Tools menu.  Doing so automatically
changes the status of all revised items.

� To manually implement a revised item on an ECO:

1. Navigate to the Revised Items window.

2. Select a revised item to implement.

3. Choose Implement from the Tools menu.

Note:  A warning message appears if the ECO does not have a
Workflow process and the revised item’s effective date is in the
future.

� To automatically implement an ECO:

1. Navigate to the Engineering Change Order window.

2. Enter or select an ECO to implement.

3. Set the ECOs status and/or the status of revised items to
Scheduled.

4. Save your work.

5. Start the AutoImplement Manager.
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See Also

Engineering Profile Options and Security Functions: page 1 – 20

Starting the AutoImplement Manager: page 1 – 19

Implementation of ECOs on Discrete Jobs and Repetitive Schedules:
page 2 – 52
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Cancelling ECOs and Revised Items 

You can cancel an entire ECO, a revised item on an ECO, or the
individual revised components on an ECO before it is implemented.
When you cancel an ECO, you can enter comments that explain the
reason for cancellation.

Cancelling an entire ECO cancels all the revised item changes and the
changes to their associated revised components.  Cancelling a specific
revised item cancels only the changes that affect that item and its
revised components.  Once you cancel an ECO you cannot update it,
but you can view a cancelled ECO.

Cancelling a revised component only affects that revised component for
that revised item.  The cancelled component can be viewed in the
Cancellation tabbed region.

Prerequisites

❑ To cancel an ECO, the Engineering Change Orders: Cancel security
function must be included as part of the responsibility.

� To cancel the entire Engineering Change Order:

1. Navigate to the Engineering Change Order window.

2. Find the ECO to cancel.

3. Choose Cancel from the Tools menu.

4. Save your work.

• Cancel the ECO, its revised items, and the associated revised
components by choosing Cancel from the Tools menu.

• Cancel a revised item by choosing the Revised Items button on
the Engineering Change Orders window, and choosing Cancel
from the Tools menu.

• Cancel a revised component by choosing the Components button
from the Revised Items window and choosing Cancel from the
Tools menu.

5. Save your work.

� To cancel an ECO’s revised items:

1. Navigate to the Engineering Change Order window.

2. Find the ECO containing revised items to cancel.
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3. Choose the Revised Items button.

4. Select the revised items to cancel.

5. Choose Cancel from the Tools menu.

6. Save your work.

� To cancel components of a revised item:

1. Navigate to the Engineering Change Order window.

2. Find the ECO containing components of revised items to cancel.

3. Choose the Revised Items button.

4. Select the revised item containing components to cancel.

5. Choose the Components button.

6. Select the components to cancel.

7. Choose Cancel from the Tools menu.

8. Save your work.

See Also

Creating an ECO: page 2 – 23

Material Requirements Planning, Oracle Master Scheduling/MRP User’s
Guide

Engineering Profile Options and Security Functions: page 1 – 20
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Viewing ECO Schedules  

View ECO information, including scheduling information, pending and
implemented ECOs, approval status, revised item status, and so on.

� To view ECO schedules:

1. Navigate to the View ECOs folder window.

2. Enter search criteria in the Find ECOs window

3. Select how to sort ECOs—by ECO identifier then effective date, or
by effective date then ECO identifier.

4. Optionally, enter revised item information:

• an effective date range

• a revised item

• a revised component

• whether to query for revised item status, and if so, any
combination of revised item statuses.

5. Choose the Find button to find ECOs based on your search criteria.

This opens the View ECOs folder window which has three tabbed
regions, each containing specific ECO information: Revised Items,
ECO Details, and Use Up.

6. Choose the New and Open buttons to navigate to the Engineering
Change Orders window.  Using the New button enables you to
create a new ECO; using the Open button enables you to view an
existing ECO.

See Also

Using Query Find, Oracle Applications User’s Guide

Using Query Operators, Oracle Applications User’s Guide

Searching For Information, Oracle Applications User’s Guide

Performing Query–by–Example and Query Count, Oracle Applications
User’s Guide

Defining Engineering Change Orders: page 2 – 22

Customizing the Presentation of Data in a Folder, Oracle Applications
User’s Guide

Engineering Change Order Schedule Report: page 4 – 6
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Use Up ECOs

Oracle Master Scheduling/MRP automatically computes and stores the
use–up date for each item it plans on each MRP plan.  The use–up date
is the date when on–hand quantity is exhausted based on projected
gross requirements.  It calculates the use–up date by applying any
on–hand quantity in inventory (supply) against any gross requirements
(demand).  When calculating the date, it does not consider scheduled
receipts or repetitive schedules as supply.

Revised Item Effective Dates Linked to Use–Up Dates

When you define a revised item on an ECO, you can base the revised
item effective date on the use–up date of another item.

When you define a revised item on an ECO, you can select the use–up
date for all components of the revised item and the use–up date of the
revised item itself for all MRP plans that include those items.  Doing so
will default the plan name and use–up item.  The revised item effective
date is now linked to a use–up date.

Alternatively, for a revised item, you can select a use–up item, which
can be any component of the revised item or the revised item itself.  But
since the plan name is not specified, the revised item effective date is
not linked to a use–up date.

Use–Up Alerts

Engineering uses Oracle Alert to automatically notify planners
whenever the MRP planning process computes a new use–up date for
an item if it is a use–up item for an ECO revised item.  For example, if
revised item A specifies item B as its use–up item (so the revised item
effective date for A equals B’s use–up date), then if the MRP planning
process computes a different use–up date for B, Oracle Alert notifies
the planner for A that B’s use–up date no longer equals the revised
item effective date for A.

See Also

Material Planning Logic, Oracle Master Scheduling/MRP User’s Guide

Reviewing the Horizontal Plan, Oracle Master Scheduling/MRP User’s
Guide

Creating an ECO: page 2 – 23
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Oracle Engineering Alerts: page B – 2

MRP Planning for ECOs 

Oracle Master Scheduling/MRP lets you consider unimplemented
ECOs when you plan material requirements and considers use–up date
changes in some cases.

Unimplemented ECO Revised Items Planning

When you define an ECO, specify whether the MRP planning process
should plan for an ECO revised item.  This lets you order material and
plan resources that you need to build a future revision in advance.
When the MRP planning process explodes requirements for a planned
order based on a planned order start date, it generates requirements
considering component changes introduced on ECO revised items so
specified.

Use–up ECOs Planning

The planning process automatically changes revised item effective
dates and considers those new effective dates in the current MRP plan
only when the use–up date changes and the revised item is the use–up
item.  The planning process then uses the updated effective date for
component changes when it explodes requirements for planned orders.

See Also

Material Requirements Planning, Oracle Master Scheduling/MRP User’s
Guide



2 – 52 Oracle Engineering User’s Guide

Unreleased Item Revisions in Oracle Work in Process

In Work in Process, you can open discrete jobs or schedules considering
pending engineering changes.  Each user can define a job with released,
scheduled, and implemented engineering changes, but you can control
whether a user or a responsibility can define a job considering
unreleased engineering changes.

If you set the WIP: Exclude Open ECOs profile option to Yes, Work in
Process sees the effects of only released, scheduled, and implemented
ECO revised items when you choose a revision or revision date and
when Work in Process explodes the bill of material.  Work in Process
also considers open (unreleased) ECOs if you set this profile option to
No.

See Also

Overview of Discrete Manufacturing, Oracle Work in Process User’s
Guide

Overview of Repetitive Manufacturing, Oracle Work in Process User’s
Guide

Implementation of ECOs on Jobs and Schedules

You can indicate whether to update work in process requirements
when you implement an ECO revised item.  When you implement the
revised item that is set to update work in process, the bill of material is
automatically re–exploded and updated for all unreleased discrete jobs
and repetitive schedules for the item.

If you have updated component material requirements for the
unreleased job or schedule, you lose these updates after you implement
the revised item.

Released, Complete, and On hold Repetitive Schedules

For repetitive schedules, if you have not moved assemblies beyond the
Queue intraoperation step of the first operation, Work in Process
automatically regenerates the bill and component requirements for the
repetitive schedule to include the effects of the ECO.

If you have moved assemblies beyond the Queue intraoperation step of
the first operation, when you implement the ECO, Work in Process
splits the schedule into two schedules that take the place of the original
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schedule.  The first schedule uses the original bill and the second new
schedule uses the revised bill that includes any revised item or
component changes.  Work in Process assigns the two new schedules a
status of Released, Complete, or On hold, depending on the status of
the original schedule.

The schedule splits based on the number of assemblies in process
(moved past the Queue intraoperation step of the first operation if you
are using routings) on the original routing.  That number is rounded up
to the nearest day so that you can finish your day’s work using the
original bill.  The next day production starts using the revised bill and a
new schedule.

The following example best illustrates this procedure.

Example

Released Schedule:

• Production rate = 50 per day

• Process days = 4 days

• Total quantity of schedule = 200 units

• Throughput = 1 day
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The following diagram illustrates the original schedule:

Shop floor distribution of assemblies before the implementation of the
ECO for the original schedule:

• 80 units spread in the routing beyond queue of the first operation

• 120 units in queue of the first operation

Original schedule dates:

• First unit start date = Day 1

• First unit complete date = Day 2

• Last unit start date = Day 4

• Last unit complete date = Day 5

Since the daily quantity is 50, this means that production is in its
second day.  Therefore, if you implement the ECO now, the schedule
splits after the second day’s work is completed.
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If you implement a change order for the item on Day 3 (Today), the
shop floor distribution of assemblies following the implementation of
the ECO are:

New Schedule 1 = 100 total units

• 20 units in queue of the first operation

• 80 units spread in the routing beyond queue of the first
operation.  These 80 units are located exactly where they were
before the implementation of the ECO.

New Schedule 2 = 100 total units

• 100 units in queue of the first operation.  The reason that there
are only 100 assemblies and not 120 assemblies is that only two
process days remain in the schedule; therefore, only two process
days worth of assemblies can be put into new schedule 2.

Schedule dates following the implementation of the ECO:

New Schedule 1:

• First unit start date = Day 1

• First unit complete date = Day 2

• Last unit start date = Day 2

• Last unit complete date = Day 3

New Schedule 2:

• First unit start date = Day 3

• First unit complete date = Day 4

• Last unit start date = Day 4

• Last unit complete date = Day 5
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The following diagram illustrates the split schedule:

All material that you issued to the original schedule remains with new
schedule 1.  Material requirements for new schedule 1 are changed to
match the new number of assemblies to complete.  Material
requirements for the altered assembly are exploded for new schedule 2
for the number of assemblies assigned to the new schedule 2.

See Also

Overview of Discrete Manufacturing, Oracle Work in Process User’s
Guide

Overview of Repetitive Manufacturing, Oracle Work in Process User’s
Guide
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Purging ECOs

You can purge fully implemented engineering change information from
the database.  You can choose a range of ECOs and a date.  Engineering
purges all fully implemented or cancelled ECOs on or before that date.

When you purge ECOs, Engineering removes all implemented and
cancelled ECOs as of that date from the database, along with all related
information (except for the revision history of the bill itself).  You
cannot view or report ECO information once you purge it.

� To purge an ECO:

1. Navigate to the Purge Engineering Change Order window.  See:
Submitting a Request, Oracle Applications User’s Guide.

2. Enter a range of ECOs to purge.

3. Indicate whether to purge implemented ECOs.

4. Indicate whether to purge cancelled ECOs.

5. Enter a date on or before which all implemented and/or cancelled
ECOs are purged.



2 – 58 Oracle Engineering User’s Guide

Engineering Change Orders Field Reference

This section describes the use of certain major fields.

ECO Statuses

Whenever this status is updated, the status of all revised items is also
updated.

The ECO is not complete; you can still make
changes.  MRP Active is defaulted to on.

The ECO cannot be implemented.  The status of all
pending revised items is set to Hold.  MRP Active
defaults to off.

The entire ECO is released from the currently
responsible ECO department.  The status of all
pending revised items is set to Released.  MRP
Active defaults to on.

The ECO is scheduled for auto–implementation.
An ECO can only have this status if the approval
status is Approved.  MRP Active defaults to on.

The ECO is implemented manually.  You can no
longer make changes to an implemented ECO.

No more changes allowed.  All unimplemented
revised items are cancelled.

ECO Revised Item Statuses

These statuses are updated by changes to the ECO status.

Changes to the revised item are still in process or
not complete.  The MRP active attribute will be
updated to Yes.  This is the default.

Changes to the revised item are on hold; you
cannot implement them.

Changes to the revised item have been released
and can be implemented manually.  The revised
item has not been scheduled for
auto–implementation.

Open

Hold

Release

Schedule

Implement

Cancel

Open

Hold

Release
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The revised item is scheduled for
auto–implementation.  You can only set the revised
item to Schedule if the ECO status is Approved.
The MRP active attribute is updated to on.

The revised item has been implemented manually
or automatically.  You cannot list additional
changes for implemented revised items.

The revised item has been cancelled.

ECO Approval Statuses

If you do not tie an Oracle Workflow process to the ECO, the only valid
approval status is No Approval Needed.

The ECO has not been submitted to the Workflow
approval process.

Engineering has started the Workflow process.

Cannot schedule or implement the ECO or any
revised items.

Approved for release, to schedule, or to
implement.

Indicates that an error occurred while Workflow
was processing the ECO approval.

Disposition Field

These values describe the disposition of inventory and work in process
inventory affected by an engineering change order (ECO).

The ECO does not affect the revised item in WIP
and inventory.  This is the default.

Scrap the revised item in WIP and inventory when
you implement the revised item.

Scrap the revised item only in inventory when you
implement the revised item.

Scrap the revised item only in WIP when you
implement the revised item.

Schedule

Implement

Cancel

Not Submitted
for Approval

Approval
Requested

Rejected

Approved

Processing Error

No change
required

Scrap WIP and
inventory

Scrap only
inventory

Scrap only WIP
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Rework the revised item in WIP and inventory
when you implement the revised item.

Rework the revised item only in inventory when
you implement the revised item.

Rework the revised item only in WIP when you
implement the revised item.

Use the revised item until you exhaust WIP and
inventory for the item.

Use the revised item until you exhaust WIP for the
item.

Use the revised item until it reaches a particular
serial number.

Rework
inventory and
WIP

Rework only
inventory

Rework only WIP

Exhaust WIP and
inventory

Exhaust only
WIP

Exhaust on serial
number
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Engineering Prototypes

his chapter tells you everything you need to know about using
engineering prototypes, including:

• Overview of Engineering Prototype Environment: page 3 – 2

• Engineering Bills of Material and Routings: page 3 – 5

• ECOs on Engineering Items and Bills: page 3 – 6

• Transferring or Copying Engineering Items, Bills, and Routings:
page 3 – 8
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Overview of Engineering Prototype Environment

Oracle Engineering enables you to move toward concurrent
engineering by integrating engineering prototype data with
manufacturing data.  Each department that accesses engineering item
information can perform the same functions on prototypes as all
departments do for manufactured assemblies.  With engineering item
information, you can separate released product designs, controlled
distribution products, and alternate manufacturing methods for
existing products from your manufacturing data.

Engineering enables you to create engineering items, bills of material
and routings the same way you define manufacturing item
information.

Note:  This does not apply to Product Families.  See:  

Each item defined in Engineering is assigned to engineering.  You can
define engineering items and assign item attribute details as you do for
manufacturing items.  You can perform any function with an
engineering item that you do for a manufacturing item, including:

• revision control

• track inventory

• value inventory transactions

• rollup costs

• update frozen standard costs

• plan in MPS and MRP

• sell on customer orders

• purchase on purchase orders

• build in WIP and issue to a WIP job

Item Catalog for Group Technology

When you design new products, search for existing items that meet
your requirements before you define a new engineering item.  Doing so
can help prevent duplicate items.  When you define an engineering or
manufacturing item, you can classify the item by any number of
characteristics.

For example, you can catalog manufacturing items and engineering
items by three descriptive elements—form, fit, and function.  Before you
create a new engineering item, search the item catalog for all items that
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match any combination of these elements, such as ”heated plastic” and
”fastener”.  You can further restrict your search with other item details,
including organization, item type, item category, and item status.  If an
item that meets your search criteria does not exist, you can create a
new engineering item and assign the values of ”heated plastic” to form
and ”fastener” to function.  See: Overview of Item Catalogs, Oracle
Inventory User’s Guide.

Engineering Item Status

You can define item statuses for each phase of your product life cycle.
Engineering enables you to control engineering item attribute
information by item status, so you can manage the introduction of new
products.  For example, you may define an item status ”Design
Released” and assign this status to all engineering product designs
released from Design Engineering to your organization.  You can
control a ”Design Released” item so that it cannot be built, purchased,
or sold.  As your product design matures, you can assign an item status
of ”Alpha” to your item so you can build or purchase it, but not
include it on customer orders.  After the product design and process
stabilize, you may assign a ”Beta” item status to your item so you can
build, purchase, and sell the item in small quantities.  See: Defining
Item Status Codes, Oracle Inventory User’s Guide.

Engineering Item Costing

You can specify item costs, roll up costs, and update frozen standard
costs for engineering items.  When you assign item costs, you can
specify cost elements, sub–elements, activities, basis and rates, the
same way you assign costs for manufacturing items.  Oracle Cost
Management lets you roll up and update manufacturing and
engineering item costs by item, category, or across all items.  After you
assign, roll up, and update item costs, you can review cost information
for all cost types available to engineering.  You can restrict access to
item cost details in Engineering by cost type.

Engineering Item Purchasing

For each engineering item you define, you can enable the item for use
in Oracle Purchasing.  To include engineering items on your purchase
orders and requisitions, you can assign default buyer, supplier, price
tolerance, and account information the same way you assign
purchasing details to manufacturing items.  You can receive, return, or
adjust engineering items the same way you receive manufacturing
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items on purchase orders.  For costed engineering items, you can track
purchase price and compute purchase price variance the same way you
cost other purchased items.  With item status control, Engineering also
enables you to control purchasing functions at any point in an
engineering item’s life cycle.

Engineering Item Planning

Engineering enables you to plan engineering items in Oracle Master
Scheduling/MRP the same way you plan manufacturing items.  When
you define an engineering item, you can assign a MPS/MRP planning
method, planning time fence, shrinkage rate, and other planning
details.  In Master Scheduling/MRP, you can forecast engineering items
and manufacturing items, load forecast details, and consume forecasts
with existing sales orders.  Master Scheduling/MRP computes material
requirements for engineering and manufacturing items using the
master schedule, engineering or manufacturing bills of material,
scheduled receipts, and inventory information.  You can also control
planning functions for engineering items by item status to track an
engineering item’s life cycle.  See: Overview of Forecasting, Oracle
Master Scheduling/MRP User’s Guide and Two–Level Master Scheduling,
Oracle Master Scheduling/MRP User’s Guide.

Discrete Jobs for Engineering Items

When you define an engineering item, you can enable the item for use
in Oracle Work in Process.  To build an engineering assembly or
prototype a new process, you define a discrete job using an engineering
bill of material or routing.  You can issue engineering and
manufacturing items to jobs, as well as collect resource, material, and
overhead costs based on an engineering routing.  You can place
finished engineering assemblies into inventory the same way you place
manufacturing assemblies into inventory.  To track an engineering
item’s life cycle, you can update item status and control when to build
an engineering item or prototype a new process in Work in Process.

Item Types and Bill of Material Types

Each item can be identified as an engineering item and enabled for use
in Engineering using two item master attributes, Engineering Item and
BOM Item Type.  The BOM Allowed item attribute must also be set to
Yes.
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The Engineering Item attribute indicates whether the item exists in
engineering.  If not, it is a manufacturing item.  This attribute is not
updatable when defining the engineering item.  When an item is
transferred to manufacturing, the Engineering Item attribute is
disabled.

You can enable any item for use in Engineering when you assign one of
the following four values for the BOM Item Type item attribute:
standard, model, option class, or planning.

You can define an engineering item and an engineering bill of material
for a manufacturing item enabled in Oracle Bills of Material, but you
cannot define manufacturing bills of material for engineering items.

See Also

Overview of Bills of Material, Oracle Bills of Material User’s Guide

Bill of Material Types, Oracle Bills of Material User’s Guide

Creating a Bill of Material, Oracle Bills of Material User’s Guide

Overview of Routings, Oracle Bills of Material User’s Guide

Creating a Routing, Oracle Bills of Material User’s Guide

Access Control by Item Type, Oracle Bills of Material User’s Guide

Deleting Items, Bills, Routings, Components, and Operations, Oracle
Bills of Material User’s Guide

Creating Custom Deletion Constraints, Oracle Bills of Material User’s
Guide

Defining Items, Oracle Inventory User’s Guide

Engineering Bills of Material and Routings

You can define an engineering bill of material or routing as alternates
for a manufacturing bill or routing.  This enables you to prototype
variations from the primary bill of material that produce the same
assembly.

You can specify a list of item catalog descriptive elements for model
and option class engineering bills.  After you release the engineering
bill to manufacturing and take customer orders for specific
configurations, Bills of Material creates the new configuration item and
automatically assigns values to each catalog descriptive element.
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Engineering lets you assign manufacturing and engineering items as
components to the engineering bill of material.

Each routing you define can exist either in engineering or in
manufacturing, and both engineering and manufacturing routings
share the same resource, department, and standard operation
information.

You can calculate manufacturing and cumulative lead times for
engineering items.

See Also

Overview of Bills of Material, Oracle Bills of Material User’s Guide

Creating a Bill of Material, Oracle Bills of Material User’s Guide

Primary and Alternate Bills of Material, Oracle Bills of Material User’s
Guide

Overview of Routings, Oracle Bills of Material User’s Guide

Creating a Routing, Oracle Bills of Material User’s Guide

Assigning Descriptive Elements, Oracle Bills of Material User’s Guide

Lead Time Management, Oracle Bills of Material User’s Guide

ECOs on Engineering Items and Bills

Engineering enables you to define engineering change orders (ECOs)
for manufacturing and engineering items.  You can also mass change
engineering bills of material the same way you manage mass changes
to manufacturing bills of material.

ECO Types

Engineering controls the access to ECOs and the changes you can
specify on an ECO.  For each ECO type, you can specify if ECOs of this
type can update engineering items.  Only users whose profile option
indicates they can update engineering items can choose ECO types that
update engineering item information.  If you define a new bill of
material using an ECO with an ECO type that updates engineering
items, Engineering creates the bill as an engineering bill when you
implement the ECO.
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Profile Options

Engineering uses the following four profile options to control the types
of items you can change on an ECO:

• ENG: Engineering Item Change Order Access (engineering
items)

• ENG: Model Item Change Order Access (model and option class
items)

• ENG: Planning Item Change Order Access (planning items)

• ENG: Standard Item Change Order Access (standard items)

See Also

Creating an ECO: page 2 – 23

Defining ECO Types: page 1 – 9

Engineering Profile Options and Security Functions: page 1 – 20
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Transferring or Copying Engineering Items, Bills, and Routings  

You must transfer an engineering item prior to, or simultaneously with,
its engineering bill of material and/or routing.  When copying items,
bills, and routings, all information must be copied simultaneously.

Note:  Engineering does not transfer or copy an item, bill, or
routing if it already exists in manufacturing.  Also, information
transferred to manufacturing is still available to engineering; it is
not copied.

Transferring and copying engineering data is organization specific.
That is, you can only transfer or copy an engineering item, bill, or
routing to manufacturing within the same organization.

Engineering Items

All information associated with the engineering item is transferred (or
copied).

If you copy an engineering item, you must provide a new name and
description.  The original item information is retained in engineering.

When you transfer an engineering item assigned to a category set
different from the inventory category set, Engineering automatically
assigns the new manufacturing item to the inventory category set.
Engineering also enables you to assign a new item revision and lets you
reference an ECO when you transfer an engineering item.

Engineering Bills of Material

All bill information—including all engineering item components on a
single level bill for an item is transferred (or copied).  For multiple
levels of engineering item components, you must transfer each
engineering bill level by level, starting from the lowest level.

You can assign a new item revision and reference an ECO when you
transfer an engineering bill of material.  When you transfer an
engineering bill of material, you can specify whether to transfer all
components, current effective components, or current and future
effective components.  You can also specify whether to transfer pending
component information from an ECO.

With this transfer criteria, Engineering transfers all engineering items
that meet your criteria and that are components on the single level bill
of material.  For bills of material that reference a common engineering
bill, you must transfer the common bill to manufacturing before you
transfer any engineering bills that reference the common bill.
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Engineering Routings

When you transfer a bill of material without transferring the
engineering routing, all components on the manufacturing bill report to
the operation sequence 1, regardless of the operations on the
engineering routing.  If components of the bill of material overlap (the
same component item appears twice) at operation sequence one,
Engineering does not transfer the engineering bill of material until you
also transfer the engineering routing.  If you transfer the engineering
bill of material and routing simultaneously, components on the
manufacturing bill report to the appropriate operation on the
manufacturing routing.

When you transfer a routing, you can also specify a new routing
revision and reference an ECO.  Engineering transfers all operations,
current effective operations, or future effective operations depending
on your transfer criteria.  For routings that reference a common
engineering routing, you must transfer the common routing to
manufacturing before you transfer any engineering routings that
reference the common routing.

Prerequisites

❑ You can only transfer (or copy) standard, model, option class, or
planning items, bills, or routings if you have access to them.  See:
Engineering Profile Options and Security Functions: page 1 – 20.
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� To transfer or copy engineering items data to manufacturing:

1. Navigate to the Transfer to Manufacturing window.

2. Enter an item and indicate whether to transfer (or copy) item, bill,
and routing data (if applicable).

Note:  When copying an engineering bill to manufacturing, you
must copy the item simultaneously with its bill and/or routing.

3. Optionally, enter a new item or routing revision (if applicable).
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The revision must be higher than the current revision (as shown)
and can be alphanumeric.

4. Optionally, open the Alternates tabbed region and for Selection,
select Specific to transfer (or copy) a specific alternate, select
Primary to transfer the primary alternate, or select All to transfer
all alternates.

Leaving this blank will transfer (or copy) the primary and all
alternates (if any).

To transfer (or copy) a specific alternate, you must enter its name.

5. Open the ECO, Description tabbed region and enter an ECO.  This
is for informational purposes only.

6. If you are copying data, you must open the Manufacturing Items
tabbed region and enter a new item name and description.

7. If you are transferring (or copying) bills, indicate if only
implemented components should be transferred.

8. Select whether to transfer (or copy) All past, Current (effective on
the specified revision date), or Future components and/or
operation steps associated with the assembly.  The default is
Current.

If you select Current or Future and Current, enter an effective date.

9. Choose the Transfer (or Copy) button.

See Also

Copying Bill and Routing Information, Oracle Bills of Material User’s
Guide
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C H A P T E R

4
T

4 – 1Reports

Reports

his chapter describes Oracle Engineering reports.  Each
description includes a sample report, with a description of submission
parameters.
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Engineering Change Order Approval Lists Report 

This report lists the approvers for engineering change orders (ECOs).
When you change the approval status of an ECO to Ready to Approve,
Oracle Alert automatically sends an alert to each approver on the list
indicating that an ECO awaits their approval.

Report Submission

In the Submit Requests window, select Engineering Change Order
Approval Lists Report in the Name field.

Report Parameters

Approval List Names From/To

To restrict the report to a range of approval list names, select beginning
and ending approval list names.

See Also

Submitting a Request, Oracle Applications User’s Guide
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Engineering Change Order Detail Report 

This report contains current or historical engineering change order
(ECO) information.  You can sort the report by engineering change
notice or creation date.  You can report all changes, current pending
changes, or historical changes.  You can run the report for all
engineering change notices or for a range.

Report Submission

In the Submit Requests window, select Engineering Change Order
Detail Report in the Name field.

Report Parameters

Engineering Change Orders From/To

To restrict the report to a range of engineering change orders, select the
beginning and ending engineering change orders.

Dates From/To

To restrict the report to a range of dates, select the beginning and
ending dates.

Status

Enter Open, Hold, Scheduled, Cancelled, Implemented, or Released to
indicate the status of the ECO to print.  See: ECO Statuses: page 2 – 58.

Additional Component Detail

Enter Yes or No to indicate whether to print ECO component detail.

Order Entry Component Detail

Enter Yes or No to indicate whether to print ECO order entry
component detail.

See Also

Submitting a Request, Oracle Applications User’s Guide
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Engineering Change Order Priorities Report 

This report lists engineering change order (ECO) priorities that you
defined for Oracle Engineering.  ECO priorities enable you to specify
the urgency of your ECO.  Engineering uses ECO priorities for
reference only.

Report Submission

In the Submit Requests window, select Engineering Change Order
Priorities Report in the Name field.

See Also

Submitting a Request, Oracle Applications User’s Guide



4 – 5Reports

Engineering Change Order Reasons Report 

This report lists the engineering change order (ECO) reasons that you
defined for Oracle Engineering.  You can use engineering change
reasons to categorize your ECOs.  Engineering uses ECO reasons for
reference only.

Report Submission

In the Submit Requests window, select Engineering Change Order
Reasons Report in the Name field.

See Also

Submitting a Request, Oracle Applications User’s Guide
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Engineering Change Order Schedule Report 

This report lists pending engineering change order (ECO) schedule
information up to a specified date.  You can run the report for all ECOs
or for a range.

Report Submission

In the Submit Requests window, select Engineering Change Order
Schedule Report in the Name field.

Report Parameters

Print Components

Enter either Yes or No to indicate whether you want to print revised
components associated with the revised item.

Engineering Change Order Type

Enter an engineering change order type to print engineering change
orders associated with it.

Engineering Change Orders From/To

To restrict the report to a range of Engineering Change Orders, select
the beginning and ending Engineering Change Orders.

Effective Dates From/To

To restrict the report to a range of dates, select the beginning and
ending dates.

Revised Item Status

Enter Open, Hold, Scheduled, Cancelled, Implemented, or Released to
indicate the status of the revised item to print.

Display Option

Choose one of the following options:

Report the pending and implemented engineering
change orders.

All
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Report the implemented engineering change
orders. 

Report the current engineering change orders.
Oracle Engineering displays this option as the
default.

Revised Item 

Enter a revised item to print.

Revised Component

Enter a revised component to print.

Sort Criteria 1

Choose one of the following options.  The report sorts ECOs first in this
order, then in the specified order for Sort Criteria 2 and Sort Criteria 3.

Sort ECOs first by ECO.  Oracle Engineering
displays this option as the default.

Sort ECOs first by effective date.

Sort ECOs first by item number.

Sort Criteria 2

Choose one of the following options.  Engineering sorts the ECOs by
the first sort type and then by this sort type within the first type.

Sort ECOs by ECO.

Sort ECOs by effective date.

Sort ECOs by item number.  Oracle Engineering
displays this option as the default.

Historical changes

Pending changes

ECO

Effective date

Item number

ECO

Effective date

Item number
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Sort Criteria 3

Choose one of the following options.  Engineering sorts the ECOs by
the first sort type, then by the second sort type within the first type,
and finally by this sort type within the second type.

Sort ECOs by ECO.

Sort ECOs by effective date.  Oracle Engineering
displays this option as the default.

Sort ECOs by item number.

See Also

Submitting a Request, Oracle Applications User’s Guide

ECO

Effective date

Item number
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Engineering Change Order Types Report 

This report lists the change orders types that determine the types of
items and bills of material you can modify on engineering and mass
change orders.

Report Submission

In the Submit Requests window, select Engineering Change Order
Types Report in the Name field.

See Also

Submitting a Request, Oracle Applications User’s Guide
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A P P E N D I X

A
T

A – 1Windows and Navigator Paths

Windows and
Navigator Paths

his appendix shows you the default navigator path for each
Oracle Engineering window.  Refer to this appendix when you do not
already know the navigator path for a window you want to use.
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Engineering Windows and Navigator Paths

For windows described in other manuals:

See... Refer to this manual for a complete window description.

BOM Oracle Bills of Material User’s Guide

CAP Oracle Capacity User’s Guide

CST Oracle Cost Management User’s Guide

Flex Oracle Applications Flexfields Manual

GL Oracle General Ledger User’s Guide

HR Oracle Human Resources User’s Guide

PO Oracle Purchasing User’s Guide

MRP Oracle Master Scheduling/MRP User’s Guide

SYS Oracle System Administrator’s Guide

User Oracle Applications User’s Guide

Text in brackets ([ ]) indicates a button.

Engineering Responsibility

Window Name Navigation Path

Approval History: page
2 – 26

ECOs > ECOs > [Approvals]

Approval Dates: page
2 – 26

ECOs > ECOs > [Special] > View Dates

Approval Lists: page
1 – 17

Setup > Approval Lists

Assign Cross Reference
Types (See INV)

Prototypes > Items > Cross References > [Assign]

Bill Components
Comparison (See BOM)

Prototypes > Bills > Comparison

Bill Details (See BOM) Prototypes > Bills > Bills > [Bill Details
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Engineering Responsibility

Bill Documents (See
BOM)

Prototypes > Bills > Documents

Bills of Material (See
BOM)

Prototypes > Bills > Bills

Calculate Lead Times
(See BOM)

Prototypes > Routings > Lead Times

Change Types: page
1 – 9

Setup > Change Types

Change Type Processes:
page 1 – 9

Setup > Change Types > [Processes]

Component Changes:
page 2 – 43

ECOs > Mass Changes > [Changes]

Component Changes
(See BOM)

Prototypes > Bills > Mass Changes > [Changes]

Copy to Manufacturing:
page 3 – 8

Copy to Manufacturing

Cross Reference Types
(See INV)

Prototypes > Items > Cross References

Deletion Constraints
(See BOM)

Setup > Delete Constraints

Departments (See BOM) Prototypes > Routings > Departments

Descriptive Elements
(See BOM)

Prototypes > Bills > Bills > [Elements]

ECO Autonumbering:
page 1 – 11

Setup > AutoNumbering

ECO Department (See
HR)

Setup > ECO Department

ECO Priorities: page
1 – 14

Setup > Priorities

Engineering Change
Orders: page 2 – 22

ECOs > ECOs
ECOs > Schedules

Engineering Master Item
(See INV)

Prototypes > Items > Master Items

Engineering
Organization Item (See
INV)

Prototypes > Items > Organization Items
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Engineering Responsibility

Enter Person (See HR) Setup > Employees

History: page 2 – 35 ECOs > ECOs > [Revised Items] > [History]

Import Bills and
Routings (See BOM)

Prototypes > Bills > Import

Indented Bill of Material
(See BOM)

Prototypes > Bills > Indented Bills

Item Attributes (See
INV)

Prototypes > Items > View Item Details > [Attrib-
utes]

Item Catalog Groups
(See INV)

Prototypes > Items > Catalog Groups

Item Documents (See
User)

Prototypes > Items > Documents

Item Relationships (See
INV)

Prototypes > Items > Related Items > [Find]

Item Revisions: page
2 – 40

ECOs > ECOs > [Revised Items] > [Revisions]

Item Revisions (See
BOM

Prototypes > Bills > Bills > [Revision]

Item Search (See INV) Prototypes > Items > Item Search > [Find]

Item Template (See INV) Prototypes > Items > Item Template > [Find] > Item
Templates Summary > [Open]

Item WhereUsed (See
BOM)

Prototypes > Bills > Item WhereUsed

Mass Change Bills: page
2 – 43

ECOs > Mass Changes

Operation Resources
(See BOM)

Prototypes > Routings > Routings > [Operation Re-
sources]

Reasons: page 1 – 16 Setup > Reasons

Reference Designators:
page 2 – 41

ECOs > ECOs > [Revised Items] > [Components] >
[Designators]

Reference Designators
(See BOM)

Prototypes > Bills > Bills > [Designators]

Resources (See BOM) Prototypes > Routings > Resources

Resource WhereUsed
(See BOM)

Prototypes > Routings > Resource WhereUsed
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Engineering Responsibility

Revised Components:
page 2 – 37

ECOs > ECOs > [Revised Items] > [Components]

Revised Items: page
2 – 32

ECOs > ECOs > [Revised Items]

Routing Details (See
BOM)

Prototypes > Routings > Routings > [Routing De-
tails]

Routing Documents (See
BOM)

Prototypes > Routings > Documents

Routing Revisions (See
BOM)

Prototypes > Routings > Routings > [Routing Revi-
sions]

Routings (See BOM) Prototypes > Routings > Routings

Standard Operations
(See BOM)

Prototypes > Routings > Standard Operations

Start AutoImplement
Manager: page 1 – 19

Setup >AutoImplement

Substitute Components:
page 2 – 40

ECOs > ECOs > [Revised Items] > [Components] >
[Substitutes]

Substitute Components
(See BOM)

Prototypes > Bills > Bills > [Substitutes]

Transfer to
Manufacturing: page
3 – 8

Transfer to Manufacturing

View ECOs: page 2 – 49 ECOs > Schedules
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Oracle Engineering Character Mode Forms and Corresponding GUI
Windows

The following table matches character mode forms with their
corresponding GUI windows or processes. This information
supplements Windows and Navigator Paths in the product online
documentation.  Text in brackets ([ ]) indicates a button.

The GUI Navigator paths are based on the Engineering responsibility.

For more information on any window, navigate to the window and
choose the help icon.

Character Mode Form and Menu Path GUI Window or Process, and Navigation Path

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
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Assign Key Flexfield Security Rules

\Navigate Setup Flexfields Key Security Assign
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Assign Security Rules

Navigator:  Setup > Flexfields > Key > Security >
Assign
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Assign Security Rules

\Navigate Setup Flexfields Validation Security
Assign
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Assign Security Rules

Navigator:  Setup > Flexfields >Validation > Security
> Assign
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Bill of Material Comparison Report

\Navigate Report Bill Compare

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Bill Components Comparison

Navigator:  Prototypes > Bills > Comparison
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Bill of Material Loop Report

\Navigate Report Bill LoopCheck
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Engineering Bill Reports

Navigator:  Reports > Bills
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Bill of Material Structure Reports

\Navigate Report Bill Structure
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Engineering Bill Reports

Navigator:  Reports > Bills
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Calculate Lead Times

\Navigate Prototype Leadtimes
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Calculate Lead Times

Navigator:  Prototypes > Routings > Lead Times
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Change Organization

\Navigate Other ChangeOrg
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Organization

Navigator:  Other >  Organization

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Define Change Order Types

\Navigate Setup ECO Types
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Change Types

Navigator:  Setup > Change Types
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Define Cross–Validation Rule

\Navigate Setup Flexfields Key Rules
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Cross–Validation Rules

Navigator:  Setup > Flexfields > Key > Rules

Table 4 – 1    (Page 1 of 7) 
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GUI Window or Process, and Navigation PathCharacter Mode Form and Menu Path
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Define Descriptive Flexfield Segments

\Navigate Setup Flexfields Descriptive Segments
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Descriptive Flexfield Segments

Navigator:  Setup > Flexfields > Descriptive >
Segments
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Define Descriptive Security Rule

\Navigate Setup Flexfields Descriptive Security
Define
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Define Security Rules

Navigator:  Setup > Flexfield > Descriptive > Security
> Define

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Define Descriptive Segment Values

\Navigate Setup Flexfields Descriptive Values
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Segment Values

Navigator:  Setup > Flexfields > Descriptive > Values
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Define ECO Approval Lists

\Navigate Setup ECO ApprovalLists
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Approval Lists

Navigator:  Setup > Approval Lists
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Define ECO Autonumbering

\Navigate Setup ECO AutoNumbering
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ECO Autonumbering

Navigator:  Setup > AutoNumbering
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Define ECO Departments

\Navigate Setup ECO Department
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Define ECO Department

Navigator:  Setup > ECO Department
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Define ECO Priorities

\Navigate Setup ECO Priorities
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ECO Priorities

Navigator:  Setup > Priorities
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Define ECO Reasons

\Navigate Setup ECO Reasons
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Reasons

Navigator:  Setup > Reasons
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Define Employees

\Navigate Setup Employee
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Enter Person

Navigator:  Setup > Employees
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Define Engineering Bill of Material

\Navigate Prototype Define Bill
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EngineeringBills of Material

Navigator:  Prototypes > Bills > Bills

Table 4 – 1    (Page 2 of 7) 



A – 9Windows and Navigator Paths

GUI Window or Process, and Navigation PathCharacter Mode Form and Menu Path

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Define Engineering Change Order

\Navigate ECO Define
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Engineering Change Orders

Navigator:  ECOs > ECOs

or

Approval History

Navigator:  ECOs > ECOs > [Approvals]

or

Approval Dates

Navigator:  ECOs > ECOs.  From the Tools menu
choose View Dates

or

ECO Revisions

Navigator:  ECOs > ECOs > [ECO Revisions]

or

View Reference  Designators

Navigator:  ECOs > ECOs > [Revised Items] >
[Components] > [Designators]

or

View Substitute Components

Navigator:  ECOs > ECOs > [Revised Items] >
[Components] > [Substitutes]
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Define Engineering Item

\Navigate Prototype Define Item Item

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Engineering Master Item

Navigator:  Prototypes > Items > Master Items

or

Engineering Organization Item

Navigator:  Prototypes > Items > Organization Items
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Define Engineering Item Revision

\Navigate Prototype Define Item Revision
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Item Revisions

Navigator:  Prototypes > Bills > Bills > [Revision]
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Define Engineering Routing

\Navigate Prototype Define Routing
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Engineering Routings

Navigator:  Prototypes > Routings > Routings

or

Routing Details

Navigator:  Prototypes > Routings > Routings >
[Routing Details]
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Define Item Catalog Groups

\Navigate Prototype Inventory Catalog Define
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Item Catalog Groups

Navigator:  Prototypes > Items > Catalog Groups
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Define Item Cross–References

\Navigate Prototype Inventory Cross–Reference
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Assign Cross Reference

Navigator:  Prototypes > Items > Cross References >
[Assign]
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Define Item Relationships

\Navigate Prototype Inventory RelatedItems
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Item Relationships

Navigator:  Prototypes > Items > Related Items >
[Find]
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Define Item Template

\Navigate prototype Inventory Template
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Item Template

Navigator:  Prototypes > Items >  Templates > [Find]
> Item Templates Summary > [Open]
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Define Key Flexfield Security Rule

\Navigate Setup Flexfields Key Security Define
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Define Security Rules

Navigator:  Setup > Flexfields > Key > Security >
Define
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Define Key Flexfield Segments

\Navigate Setup Flexfields Key Segments
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Key Flexfield Segments

Navigator:  Setup > Flexfields > Key > Segments
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Define Key Segment Values

\Navigate Setup Flexfields Key Values
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Segment Values

Navigator:  Setup > Flexfields > Key > Values
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Define Rollup Groups

\Navigate Setup Flexfields Key Groups
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Rollup Groups

Navigator:  Setup > Flexfields > Key > Groups
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Define Security Rule

\Navigate Setup Flexfields Validation Security Define
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Define Security Rules

Navigator:  Setup > Flexfields >Validation > Security
> Define

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Define Segment Values

\Navigate Setup Flexfields Validation Values
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Segment Values

Navigator:  Setup > Flexfields >Validation > Values
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Define Shorthand Aliases

\Navigate Setup Flexfields Key Aliases
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Shorthand Aliases

Navigator:  Setup > Flexfields > Key > Aliases
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Define Value Set

\Navigate Setup Flexfields Validation Set
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Value Sets

Navigator:  Setup > Flexfields > Validation >  Sets
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Delete Item Information

\Navigate Prototype Delete

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Engineering Deletion Groups

Navigator:  Delete Item Report
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Delete Items Report

\Navigate Report Delete
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Delete History Report

Navigator:  Reports > Delete Groups
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Engineering Change Order Reports

\Navigate Report ECO
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Engineering Change Order Reports

Navigator:  Reports > ECOs
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Engineering Setup Reports

\Navigate Reports Setup
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Engineering Setup Reports

Navigator:  Reports > Setup
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Implement Engineering Change Orders

\Navigate ECO Implement
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Engineering Change Orders

Navigator:  ECOs > ECOs
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Item Cost Information Report

\Navigate Report ItemCosts
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Item Cost Information Report

Use the Cost Management responsibility
Navigator:  Report > Cost > Item
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Item Reports

\Navigate Report Item
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Engineering Item Reports

Navigator:  Reports > Items
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Mass Change Bills of Material

\Navigate ECO MassChange
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Mass Change Bills

Navigator:  ECOs > Mass Changes
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Purge Engineering Change Orders

\Navigate ECO Purge
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Purge Engineering Change Orders

Navigator:  ECOs > Delete
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Routing Reports

\Navigate Reports Routing
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Engineering Routing Reports

Navigator:  Reports > Routings

Run Reports

\ Navigate Report

Submit Request window

See:  Submit Requests (Oracle Applications User’s
Guide)

Navigator:  Reports > Run
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Search Items

\Navigate Prototype Inventory Catalog Search
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Item Search

Navigator:  Prototypes > Items > Item Search > [Find]
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Start AutoImplement Manager

\Navigate Setup AutoImplement
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Start AutoImplement Manager

Navigator:  Setup >AutoImplement
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Transfer Engineering Data to Manufacturing

\Navigate Prototype Transfer
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Copy to Manufacturing

Navigator:  Prototypes > Copy to Manufacturing

or

Transfer to Manufacturing

Navigator:  Protoypes > Transfer to Manufacturing
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Update Engineering Item/Org Attributes

\Navigate Prototype Define Item Update
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Item Attributes

Navigator:  Prototypes > Items > View Item Details >
[Attributes]
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Update Personal Profile Options

\Navigate Other Profile
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Personal Profile Values

Navigator:  Setup > Profiles
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View Bill of Material Comparison

\Navigate Inquiry Bill Compare
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Bill Components Comparison

Navigator:  Prototypes > Bills > Comparison
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View Bill of Material Details

Navigate Inquiry Bill Detail
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Bill Details

Navigator:  Prototypes > Bills > Bills > [Bill Details]

View Concurrent Requests

\ Navigate Other Requests

Requests window

See:  Viewing Requests (Oracle Applications User’s
Guide)

Navigator:  Concurrent > Requests

Choose:

View Output button – to view Request Output

View Log button   – to view Request Log

Use the Menu to choose:

Tools > Managers – to view Manager Log
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View Engineering Change Order Details

\Navigate Inquiry ECO Details
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Engineering Change Orders

Navigator:  ECOs > ECOs
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View Engineering Change Order Schedule

\Navigate Inquiry ECO Schedule
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View ECOs

Navigator:  ECOs > Schedules
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View Engineering Delete History

\Navigate Inquiry DeleteHistory
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Warning: Engineering Deletion Groups

Navigator:  Prototypes > Routings > Delete Groups
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View Indented Bill of Material

\Navigate Inquiry Bill Indented
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Indented Bills of Material

Navigator:  Prototypes > Bills > Indented Bills
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View Item Attributes

\Navigate Inquiry Item Attributes
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Item Attributes

Navigator:  Prototypes > Items > View Item Details >
[Attributes]
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View Item Revision

Navigate Inquiry Item Revision
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Item Revisions

Navigator:  Prototypes > Bills > Bills > [Revision]

or

Revised Items
Navigator:  ECOs > ECOs > [Revised Items] >
[Revisions]
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View Item Usage

\Navigate Inquiry WhereUsed Item
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Item WhereUsed

Navigator:  Prototypes > Bills > Item WhereUsed
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View Routing Details

\Navigate Inquiry Routing
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EngineeringRoutings

Navigator:  Prototypes > Routings > Routings
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B – 1Oracle Engineering Alerts

Oracle Engineering
Alerts

his appendix describes the pre–coded alerts included with Oracle
Engineering.
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Engineering Alerts

Engineering includes these pre–coded alerts that you can use with or
without customizing.

ECO Approval Notification

This alert notifies all the approvers on an ECO’s approval list that an
ECO requires their approval

Periodic

Every n business days

Organization

Approvers for the ECO

To: Henry Smith
From: Oracle Alert
Subject: Approval Requested for ECO – ECO7
––––––––––––––––––––

The following Engineering Change Order needs your approval.
Please take the appropriate action and inform the Requestor
below.

Organization:     BM1     BOM Test Org 1

  ECO:              ECO7             Reason: Cost
  Priority:                         
  Approver List:    appr1            
  Approver:         Mecker, Satyajit Singh
  Requestor:        

    Revised Item:   E:EDEI_watch   
    Description:    Watch  
    Effective Date: 31–JUL–93           New Revision: 1  

Oracle Alert

ECO Use Up Date

This alert notifies the ECO planner that a plan date for a use–up item
has changed.

Periodic

Every n business days

Organization

ECO requestor

Alert Type

Periodicity

Inputs

Distribution

Alert Type

Periodicity

Inputs

Distribution
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Example:

ÍÍ
ÍÍ

To: Henry Smith
From: Oracle Alert
Subject: ECO revised item use up dates
–––––––––––––––
ECO scheduled dates for the following revised items do not
match their use up dates in MRP.  Please take the necessary
action.  

Organization: MR1  MRP Organization 1
     Planner: PRUBINFE      Description: Paul

                                    |––––––– Use Up –––––––|
ECO        Revised Item   Sch. Date  Item   Plan      Date
–––––––––– ––––––––––––––– ––––––––– ––––– –––––––– –––––––––
pxr–013    M–pxr–b         28–JAN–94 M–pxr–b  NF–MRP 13–APR–94

Oracle Alert

See Also

Overview of Oracle Alert, Oracle Applications Alert User’s Guide

Customizing Predefined Alerts, Oracle Applications Alert User’s Guide
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C – 1Oracle Engineering Special Menu

Oracle Engineering
Special Menu

his appendix describes the options on the Oracle Engineering
Tools menu.
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Engineering Tools menu

Change the status of ECOs and ECO revised items by using the Tools
menu and choosing a status.  Other functions available from the Oracle
Engineering Tools menu include:

Opens the Reschedule window to reschedule ECOs
and ECO revised items.  To reschedule ECOs, the
Engineering Change Orders: Reschedule security
function must be included as part of the
responsibility.

Opens the ECO Costs window so that you can
enter engineering or manufacturing
implementation costs.

Opens the Copy Bill window so that you can copy
a bill into an ECO.

Verifies that a bill does not contain items are not
listed as components of the same item.

Opens the Approval Dates window which shows
the date the ECO approval list was requested, the
date it was approved, or the days remaining for
approval to take place.

Aborts the Workflow approval process.  This is
only available if the ECO approval status is
Approval Requested.  This is only available if the
ECO: Approvals security function is included as
part of the responsibility.

See Also

Changing the ECO Status: page 2 – 29

ECO Statuses: page 2 – 58

ECO Revised Item Statuses: page 2 – 58

Rescheduling an ECO or Revised Items: page 2 – 28

Defining Implementation Costs: page 2 – 31

Copying Bill and Routing Information, Oracle Bills of Material User’s
Guide

Checking for Bill Loops, Oracle Bills of Material User’s Guide

Assigning an ECO Approval List and Status: page 2 – 26

Reschedule

Enter Costs

Copy Bill from

Check for Loops

Abort Approvals
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Engineering Profile Options and Security Functions: page 1 – 20
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1Glossary

GLOSSARY

activity    A business action or task which uses a resource or incurs a cost.

alternate bill of material   An alternate list of component items you can use to produce an assembly.

alternate routing   An alternate manufacturing process you can use to produce an assembly.

ANSI   American National Standards Institute which establishes national standards for the United
States.  The parent organization for X12 and also serves as the North American representative to
ISO (International Standards Organization).

approval list   A group of employees that review and control engineering change orders (ECOs).
When you create an ECO, you can assign an approval list and an approval status.  Oracle Alert
automatically notifies each approver when an ECO requires their approval.

approval status   A classification you can use to track an ECO’s approval cycle.  Approval statuses
include:  Not ready to approve, Ready to approve, Approval requested, Approved, and Rejected.
Oracle Alert automatically notifies each approver when an ECO’s approval status is set to Ready
to approve.

assigned units   The number of resource units assigned to work at an operation in a routing.  For
example, if you have 10 units of machine resource available at a department, you can assign up to
10 of these units to an operation in a routing.  The more units you assign, the less elapsed time
Work in Process schedules for the operation.

autocharge   A method of charging a discrete job or repetitive schedule for the resources consumed
at an operation.

autoimplement   To implement an ECO’s revised item automatically on its effective date by setting
the revised item status to Scheduled and running the autoimplement manager.

autoimplement manager   An Engineering program that automatically implements all ECO revised
items with a status of Scheduled and whose effective date is less than or equal to the current date.

autonumber   A function to automatically default engineering change order (ECO) numbers when
you create a new ECO.  You can define an autonumber prefix and sequence for all users across all
organizations, all users in one organization, one user across all organizations, and one user in one
organization.

bill of material   A list of component items associated with a parent item and information about how
each item relates to the parent item.  Oracle Manufacturing supports standard, model, option class,
and planning bills.  The item information on a bill depends on the item type and bill type.  The
most common type of bill is a standard bill of material.  A standard bill of material lists the
components associated with a product or subassembly.  It specifies the required quantity for each
component plus other information to control work in process, material planning, and other Oracle
Manufacturing functions.  Also known as product structures.
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bill revision   A specific version of an item which specifies the components that are active for a date
range.

BOM item type   An item classification that determines the items you can use as components in a bill
of material.  BOM Item types include standard, model, option class, and planning items.

by–product   Material produced as a residual of a production process.  Represented by negative
usage in the bill of material for an assembly.

capacity units   The number of units of a resource available in a department.  For example, the
number of machines.

charge type   See autocharge

common bill of material   An assembly that uses the bill of material of another assembly as its bill.
This enables you to reduce your maintenance effort by sharing the same bill structure among two
or more assemblies.  For example, if you have identical bills of material that produce the same
product in two different organizations, you can define common bills of material for the identical
structures.

common routing   A routing that uses the routing of another assembly as its routing.  This enables
you to reduce your maintenance effort by sharing the same routing and operations for two or
more assemblies.

component demand   Demand passed down from a parent assembly to a component.

component item   An item associated with a parent item on a bill of material.

component yield   The percent of the amount of a component you want to issue to build an assembly
that actually becomes part of that assembly.  Or, the amount of a component you require to build
plus the amount of the component you lose or waste while building an assembly.  For example, a
yield factor of 0.90 means that only 90% of the usage quantity of the component on a bill actually
becomes part of the finished assembly.

configurator   A form that allows you to choose options available for a particular model, thus
defining a particular configuration for the model.

configure–to–order   An environment where you enter customer orders by choosing a base model
and then selecting options from a list of choices.

count point operation   A default operation to move to and from where you record move and charge
resource transactions.  Also known as pay point.

cumulative manufacturing lead time    The total time required to make an item if you had all raw
materials in stock but had to make all subassemblies level by level.  Bills of Material automatically
calculates this value.  Purchased items have no cumulative manufacturing lead time.

cumulative total lead time   The total time required to make an item if no inventory existed and you
had to order all the raw materials and make all subassemblies level by level.  Bills of Material
automatically calculates this value.

delete entity   An item, bill of material or routing you choose to delete.
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delete group   A set of items, bills, and routings you choose to delete.

delete subentity   A component or operation you choose to delete.

deletion constraint   A business rule that restricts the entities you can delete.  A deletion constraint is
a test that must succeed before an item, bill, or routing can be deleted.

detailed scheduling   A method of scheduling production that considers minute to minute resource
availability information as well as exact resource requirements from routings.

disable date   A date when an Oracle Manufacturing function is no longer available for use.  For
example, this could be the date on which a bill of material component or routing operation is no
longer active, or the date a forecast or master schedule is no longer valid.

disposition   Directions that describe how to dispose of inventory affected by an ECO.  Engineering
uses ECO disposition for informational purposes only.

dynamic lead time offsetting   A scheduling method that quickly estimates the start date of an order,
operation, or resource.  Dynamic lead time offsetting schedules using the organization workday
calendar.

effective date   Date when an Oracle Manufacturing function is available for use.  For example, this
could be the date a bill of material component or routing operation becomes effective, or the date
you anticipate revised item changes become part of a bill of material and can no longer be
controlled by an ECO.

engineer–to–order   An environment where customers order unique configurations for which
engineering must define and release custom bills for material and routings.  Oracle Manufacturing
does not provide special support for this environment beyond the support it provides for
assemble–to–order manufacturing.

engineering change order (ECO)   A record of revisions to one or more items usually released by
engineering.

engineering change order department   A group of users that use the engineering change order
system.  You assign users to an ECO department to control access to your ECOs.

engineering change order reason   The purpose of an ECO.

engineering change order status   A classification you can use to track and control an ECO’s life
cycle.  ECO statuses include:  Open, Hold, Release, Schedule, Implement, and Cancelled.

engineering change order type   An ECO field that identifies the originating ECO department and
the items you can include on an ECO (manufacturing or engineering).

engineering item   A prototype part, material, subassembly, assembly, or product you have not yet
released to production.  You can order, stock, and build engineering items.

fixed lead time   The portion of the time required to make an assembly independent of order
quantity, such as time for setup or teardown.
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flow manufacturing   Manufacturing philosophy utilizing production lines and schedules instead of
work orders to drive production. Mixed models are grouped into families and produced on lines
balanced to the TAKT time.

implement   To make an ECO active so that no further changes can be made to that ECO.  Usually,
the day you implement an ECO is also the effective date for component changes.  After that date,
you must make further changes through a new ECO or directly to the bill.

implementation date   The date a component becomes part of a bill of material and is no longer
controlled through an ECO.  Implementation date does not necessarily equal the effective date.

included item   A standard mandatory component in a bill, indicating that it ships (if shippable)
whenever its parent item is shipped.  Included items are components of models, kits, and option
classes.

item   Anything you make, purchase, or sell, including components, subassemblies, finished
products, or supplies.  Oracle Manufacturing also uses items to represent planning items that you
can forecast, standard lines that you can include on invoices, and option classes you can use to
group options in model and option class bills.

item sequence   The sequence of the component item on the bill of material used to sort components
on reports.

lead time lot size   The item quantity used to compute the fixed and variable portions of
manufacturing lead time.  For manufactured items, the processing lead time represents the time
required to build this quantity.

make–to–order   An environment where customers order unique configurations that must be
manufactured using multiple discrete jobs and/or final assembly orders where the product from
one discrete job is required as a component on another discrete job.  Oracle Manufacturing does
not provide special support for this environment beyond the support it provides for
assemble–to–order manufacturing.

mandatory component   A component in a bill that is not optional.  Bills of Material distinguishes
required components from options in model and option class bills of material.  Mandatory
components in pick–to–order model bills are often referred to as included items, especially if they
are shippable.

mass change order   A record of a plan to replace, delete, or update one or more component items in
many bills of material at the same time.

minimum transfer quantity   The minimum number of assemblies to move from your current
operation to the next.  Work in Process warns you when you move less than the minimum transfer
quantity.

model bill of material   A bill of material for a model item.  A model bill lists option classes and
options available when you place an order for the model item.

model item   An item whose bill of material lists options and option classes available when you place
an order for the model item.
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occurrence   An individual quality result.  For example, a measurement that falls in or out of a
specified tolerance.  Occurrences can be charted using Oracle Quality.

offset percent   An operation resource field that holds the percent of total manufacturing lead time
required for previous operations.  For example, if all operations require a total of ten hours to
perform and the offset percent for a resource is 40%, then the resource is used four hours after the
start of the first operation.

operation   A step in a manufacturing process where you perform work on, add value to, and
consume department resources for an assembly.

operation code   A label that identifies a standard operation.

operation instructions   Directions that describe how to perform an operation.

operation offset   Elapsed days from the start of your first operation until the beginning of your
current operation.

operation sequence   A number that orders operations in a routing relative to each other.

option class item   An item whose bill of material contains a list of related options.

option dependent operation   An operation in a model or option class item’s routing that appears in
a configuration item routing only if the configuration contains an option that references that
operation.

postprocessing lead time   The time required to receive a purchased item into inventory from the
initial supplier receipt, such as the time required to deliver an order from the receiving dock to its
final destination.

reference designator   An optional identifier you can assign to a component on a bill.  For example,
when the bill requires four of a component, you can assign four reference designators to that
component, one for each usage.

requestor   The employee that creates an ECO or requests approval for an ECO.

resource   Anything of value, except material and cash, required to manufacture, cost, and schedule
products.  Resources include people, tools, machines, labor purchased from a supplier, and
physical space.

resource basis   The basis for resource usage quantity that indicates whether that quantity is required
per item or per lot.

resource sequence   The number that indicates the order of a resource in an operation relative to
other resources.

revised component   Component changes to an assembly that is a revised item on an ECO.

revised item   Any item you change on an engineering change order.  Revised items may be
purchased items, subassemblies, finished goods.

revised item status   A classification you can use to track and control a revised item’s life cycle.
Revised item statuses include Open, Released, Scheduled, Hold, Implemented, and Cancelled.
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revision   A particular version of an item, bill of material, or routing.

revision control   An inventory control option that tracks inventory by item revision and forces you
to specify a revision for each material transaction.

routing   A sequence of manufacturing operations that you perform to manufacture an assembly.  A
routing consists of an item, a series of operations, an operation sequence, and operation effective
dates.

routing revision   A specific version of a routing that specifies the operations that are active for a
date range.

setup time   The time required to for a machine or work center to convert from the production of one
item to another.

shift   A scheduled period of work for a department within an organization.

standard operation   A commonly used operation you can define as a template for use in defining
future routing operations.

standard rate   The frozen standard unit cost for a resource.

subinventory   Subdivision of an organization, representing either a physical area or a logical
grouping of items, such as a storeroom or receiving dock.

substitute item   An item that can be used in place of a component.  Master Scheduling/MRP
suggests substitutes items on some reports.

supply   A quantity of materials available for use.  Supply is replenished in response to demand or
anticipated demand.

supply type   A bill of material component field that controls issue transactions from inventory to
work in process.  Supply types supported by Work in Process include:  Push, Assembly pull,
Operation pull, Bulk, Supplier, Phantom, and Based on bill.

teardown time   The time required to clean up or restore a machine or work center after operation.

total lead time   An item’s fixed lead time plus the variable lead time multiplied by the order
quantity.  For lead time calculations, Bills of Material sets the order quantity to the item’s standard
or lead time lot size.  The planning process uses the total lead time for an item in its scheduling
logic to calculate order start dates from order due dates.

Update WIP   When Engineering automatically implements a released revised item, the work in
process requirements are automatically updated for the revised item.

usage rate   The amount of a resource consumed at an operation.

use–up item   A revised component whose MRP–planned order date and lead time offset determine
the effective date of the revised item.

variable lead time   The time required to produce one additional unit of an assembly.  To compute an
item’s total lead time multiply variable lead time by order quantity, and add an item’s fixed lead
time.
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workday calendar   A calendar that identifies available workdays for one or more organizations.
Master Scheduling/MRP, Inventory, Work in Process, and Capacity plan and schedule activities
based on a calendar’s available workdays.

workday exception set   An entity that defines mutually exclusive sets of workday exceptions.  For
each organization, you can specify a workday calendar and exception set.

workday exceptions   Dates that define plant or shift workday variations, including holidays,
scheduled maintenance, or extended downtime.

yield   See component yield.
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Oracle Corporation welcomes your comments and suggestions on the quality and usefulness
of this publication.  Your input is an important part of the information we use for revision.

• Did you find any errors?

• Is the information clearly presented?

• Do you need more information?  If so, where?

• Are the examples correct?  Do you need more examples?

• What features did you like most about this manual?  What did you like least about it?

If you find any errors or have any other suggestions for improvement, please indicate the topic, chapter,
and page number below:

Please send your comments to:

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065  USA
Phone: (650) 506–7000     Fax: (650) 506–7200

If you would like a reply, please give your name, address, and telephone number below:

Thank you for helping us improve our documentation.
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